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About This Guide

This guide describes how to install, configure, and customize Novell iPrint Appliance on your
network.

*

*

Chapter 1, “iPrint Appliance Overview,” on page 11

Chapter 2, “System Requirements for iPrint Appliance,” on page 15

Chapter 3, “Installing iPrint Appliance,” on page 17

Chapter 4, “Setting Up iPrint Appliance,” on page 25

Chapter 5, “iPrint Windows Renderer Installation and Configuration,” on page 41
Chapter 6, “AirPrint through iPrint,” on page 47

Chapter 7, “Email Printing,” on page 53

Chapter 8, “iPrint Appliance System Configuration,” on page 59

Chapter 9, “iPrint Appliance Management,” on page 67

Chapter 10, “iPrint Appliance License Information,” on page 77

Chapter 11, “iPrint Appliance Firewall Exceptions,” on page 79

Chapter 12, “Monitoring iPrint Appliance Performance with Ganglia,” on page 81
Chapter 13, “Advanced Configuration for iPrint Mobile Service (Optional),” on page 83
Chapter 14, “Backup and Restore iPrint Appliance,” on page 85

Chapter 15, “Upgrading iPrint Appliance,” on page 87

Chapter 16, “Troubleshooting iPrint Appliance,” on page 89

Chapter 17, “Known Limitations,” on page 103

Appendix A, “Supported Document Formats,” on page 105

Appendix B, “Email Service Parameters,” on page 107

Appendix C, “Traditional iPrint Client Authentication,” on page 109

Appendix D, “Printing Using Specific Printer Drivers,” on page 111

Appendix E, “Best Practices,” on page 113

Appendix F, “Installing VMware Tools,” on page 115

Appendix G, “iPrint Client Management with Novell iPrint Appliance,” on page 117
Appendix H, “iPrint Appliance Support Matrix,” on page 121

Audience

This guide is intended for Novell iPrint Appliance administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation.

About This Guide
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Documentation Updates

For the most recent version of the Novell iPrint Appliance 1.0.1 Administration Guide, and other
documentation for this product, visit the Novell iPrint Appliance 1.0.1 Documentation Web site
(http://www.novell.com/documentation/iprint-appliancel/).

For information about configuring and using the mobile app, see the iPrint Appliance User Guide, or
the Help section of the app.
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1.2

IPrint Appliance Overview

¢ Section 1.1, “What Is Novell iPrint Appliance?,” on page 11
¢ Section 1.2, “Methods of Printing,” on page 11

¢ Section 1.3, “Document Rendering,” on page 13

What Is Novell iPrint Appliance?

Novell iPrint Appliance is a virtual appliance that offers cross-platform, self-service printing for the
enterprise. It allows users to print to your current printers from all your desktops, laptops, and
mobile devices. Novell iPrint Appliance supports Active Directory and mobile identities. It scales to
fit organizations of any size and provides a single solution to manage all of your printing across
multiple office locations.

With iPrint Appliance, you can print in multiple ways:

¢ Using the Novell iPrint App

¢ Email Printing

¢ Using AirPrint (i0S Devices Only)

¢ Using Laptops or Desktops
After configuring iPrint Appliance, you can use the Novell iPrint app to print from a mobile device.
Novell iPrint submits documents for printing using the Share functionality on Android, and the Open
In functionality on iOS. To submit the print job, the app uses the IPP (Internet Printing Protocol)

method. If a direct network connection to iPrint Appliance is unavailable, the app switches to email
printing, and uses the email client configured on the device.

NOTE: By default, email printing is not enabled on iPrint Appliance. The Novell iPrint app switches
to email printing only if the administrator enables email printing.

For information about configuring and using the mobile app, see the Novell iPrint 1.0.1 User Guide, or
the Help section of the app.

IMPORTANT: By default, iPrint Appliance supports only PostScript printers. For non-PostScript
printers like PCL, or for printers that do not work with the default PostScript driver, you must install
the appropriate printer drivers. For more information on installing printer specific drivers, see
Appendix D, “Printing Using Specific Printer Drivers,” on page 111.

Methods of Printing

¢ Section 1.2.1, “Using the Mobile App,” on page 12
¢ Section 1.2.2, “Using Email Printing,” on page 12

iPrint Appliance Overview 11
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1.2.2
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1.2.3

¢ Section 1.2.3, “Using AirPrint (iOS Devices Only),” on page 12
¢ Section 1.2.4, “Using Laptops or Desktops,” on page 13

Using the Mobile App

The Novell iPrint app prints documents from mobile devices using the IPP (Internet Printing
Protocol) method. IPP is a standard network protocol for remote printing and print management.

iPrint Appliance’s print server converts documents to a printer friendly format (PostScript), and
sends them to the printer for printing.

IMPORTANT: The Novell iPrint app is available on Android and iOS platforms. To download the
Novell iPrint app, search for Novell iPrint on Google’s Play Store or Apple’s App Store.

Using Email Printing

iPrint Appliance accepts print jobs through email messages and attachments, using your existing
enterprise email infrastructure.

There are two kinds of email printing:

¢ Printing using the email client: You can print documents from any device capable of sending
emails. You can print emails by specifying email printing commands in the subject line of the
email. You can also print documents by emailing them to your printer as attachments. For more
information on email printing and commands, see Chapter 7, “Email Printing,” on page 53.

¢ Email printing through the app: The Novell iPrint app uses Direct IPP printing by default. If
Direct IPP printing fails, iPrint Appliance switches over to email printing as a fallback option.
The Novell iPrint app generates an email, attaches the document to the email, and sends the
email to iPrint Appliance. iPrint Appliance then issues the print request in the IPP format.

By default, email printing is disabled. To enable email printing, see Section 7.1, “Enabling Email
Printing,” on page 53.

IMPORTANT: For enhanced security, email printing to secure printers is disabled.

NOTE: It is important that iPrint Appliance has a high bandwidth connection to the mail server
provided during initial configuration. An email containing large attachments can take several
seconds or minutes to download, depending on the connection speed between the print server and
the mail server. This can cause delays in processing the remaining emails, thereby delaying printing
for subsequent documents.

Using AirPrint (iOS Devices Only)

AirPrint is a printing technology created by Apple for iOS devices. iOS devices can print to any
AirPrint-enabled printer, wirelessly, using Apple’s driverless printing architecture. iPrint Appliance
takes advantage of this technology, enabling non AirPrint-enabled printers to be published as
AirPrint printers over the wireless network. You can seamlessly print documents and images from

Novell iPrint Appliance 1.0.1 Administration Guide



1.2.4

1.3

1.3.1

your iOS devices over the wireless network. iOS devices do not require a software download or
driver installation. With just a few taps from any AirPrint-enabled iOS application (for example,
Mail, Photos, Safari, and iBooks), you can print to an iPrint AirPrint-enabled printer.

For more information about AirPrint through iPrint, see Chapter 6, “AirPrint through iPrint,” on
page 47.

Using Laptops or Desktops

iPrint Appliance allows enterprise users to install printers and print documents seamlessly. Users can
install printers using the iPrint URL provided by their administrator. The iPrint page displays the
available printers. Users can click a printer to install the iPrint Client, download the printer’s driver,
and create a printer on their workstation. Users can then print documents to the printer from any
application on their desktops and laptops.

To set up iPrint Appliance for desktop and laptop printing, see the Setting Up iPrint section in the
OES 11 iPrint Administration Guide.

To install the iPrint on client workstations, see the Installing and Setting Up iPrint on Client
Workstations section in the OES 11 iPrint Administration Guide.

Document Rendering

iPrint Appliance strives to provide a client independent and driverless printing environment to
mobile users. The iPrint Appliance print server performs the task of converting documents into print-
ready formats, and printing the documents. iPrint Appliance uses an internal and an external
renderer.

¢ Section 1.3.1, “Internal Renderer,” on page 13

¢ Section 1.3.2, “External Renderer,” on page 14

¢ Section 1.3.3, “Supported Document Formats,” on page 14

Internal Renderer

iPrint Appliance is bundled with LibreOffice, which is the default internal document renderer.
LibreOffice supports Open Office and image formats, and provides a good quality conversion.

NOTE: LibreOffice supports a broad range of formats, beyond the officially tested formats Writer
(odt), Calc (ods), Impress (odp), and all image formats. These formats include Static HTML pages,
Adobe PDF, and Microsoft Office. However, printing quality varies, depending on the document
complexity. We strongly recommended that you use the iPrint Windows Renderer if you intend to
print Microsoft Office and Adobe PDF formats.

iPrint Appliance Overview 13
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1.3.2

1.3.3

External Renderer

iPrint Windows Renderer is an external document renderer. For desktop-quality printing, iPrint
Windows Renderer is highly recommended. You can download iPrint Windows Renderer from the
iPrint Appliance Management Console.

iPrint Windows Renderer provides high quality rendering for Microsoft Office and PDF document
formats. The renderer uses Microsoft Office and Adobe Acrobat Pro applications to convert
documents to print-ready formats. The renderer converts the documents using a PostScript driver.
The HP Universal Print Driver for Windows - PostScript is tested and recommended. This driver
supports a broad range of devices.

NOTE: If you have printers that do not support the HP driver, you can use the drivers specific to
your printer. If your printers are PCL based and do not support PostScript, you can use the PCL
drivers instead.

You can download the latest version of HP Universal PostScript Print Driver for Windows 7 64-bit
from HP’s drivers and software page.

iPrint Windows Renderer runs on a standalone Windows 7 64-bit machine, and communicates with
the iPrint Appliance print server for document conversion. Although it is not a mandatory
requirement for iPrint Appliance, iPrint Windows Renderer is strongly recommended for desktop
quality printing.

iPrint Windows Renderer supports Microsoft Office formats such as Word, Excel, PowerPoint, and
RTF, and Adobe PDF formats.

Supported Document Formats

iPrint Appliance supports the following document formats:

¢ Open Office and LibreOffice formats (Writer, Calc, and Impress)
Microsoft Office formats (Word, Excel, PowerPoint, and RTF)

+ PDF

¢ Image formats (jpg, gif, png, bmp)

Text files (txt)

¢ Static HTML content

*

*

NOTE: Static HTML content refers to the HTML content that does not change or have dependencies
on external files such as MySQL database and JavaScript.

For a comprehensive list of supported document formats, see Appendix A, “Supported Document
Formats,” on page 105.
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2.1

System Requirements for iPrint
Appliance

¢ Section 2.1, “iPrint Appliance Requirements,” on page 15
¢ Section 2.2, “iPrint Windows Renderer Requirements,” on page 16

¢ Section 2.3, “AirPrint through iPrint Requirements,” on page 16

IPrint Appliance Requirements

iPrint Appliance works best with the virtualization software versions listed below. However, iPrint
Appliance works with any virtualization software that can run the .ovf, .vmx, or .xen file formats.
¢ Any virtualization software listed below:
¢ Hyper-V: Windows Server 2012 Hyper-V and Windows Server 2008 Hyper-V
¢ Xen 4.2.2_04-0.7.5 on SLES 11 SP2 and SLES 11 SP3
¢ VMware ESX 4.x, ESXi 4.x, ESXi 5.x or higher

¢ A VMware vSphere client 4.x or VMware vSphere client 5.x for accessing the host server and
appliance for initial configuration

¢+ VMware Workstation 9 on Windows 7 and SLES. VMware Workstation 9 is certified, however,
VMware Workstation 8 works with no major issues.

¢ Microsoft Internet Explorer 9 or 10, or the latest version of Mozilla Firefox or Google Chrome, or
Safari on Mag, for configuring and managing iPrint Appliance after installation

¢ IP address information to assign to iPrint Appliance, including:
¢ Static IP address
¢ Network mask
¢ Gateway IP address
¢ DNS host name associated with the IP address
¢ IP address of a DNS server
¢ 4 GB RAM or higher is recommended
¢ 40 GB hard disk space is recommended

NOTE: For VMware system requirements, see Minimum system requirements for installing ESX/
ESXi on the VMware support page.

System Requirements for iPrint Appliance 15
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2.2 iPrint Windows Renderer Requirements

For desktop quality printing for Microsoft Office and PDF documents, you must install an external
document renderer such as the iPrint Windows Renderer. The renderer must be installed on a
Microsoft Windows 7 64-bit system. The minimum requirements are as follows:

¢ Microsoft Windows 7 64-bit with a dual-core processor

¢ Microsoft Office 2010

¢ Adobe Acrobat X Pro or higher

¢ Microsoft .Net Framework 4

¢ HP Universal Print Driver for Windows - Postscript

NOTE: You must pre-install the PostScript driver or install it during iPrint Windows Renderer
configuration when prompted. The latest version of HP Universal Print Driver for Windows -
Postscript driver for Window 7 64-bit is highly recommended. You can download the driver
from HP’s drivers and software page.

2.3 AirPrint through iPrint Requirements

Before you can enable AirPrint through iPrint, your network must meet the following requirements.

2.3.1 Hardware Requirements

¢ Router or Gateway with an option to forward mDNS (Apple Bonjour) multicast advertisements
on all or selected wireless VLANSs

¢ Wireless router that supports mDNS (Apple Bonjour) between wired and wireless machines

The wireless routers are expected to have the capability for IGMP snooping. IGMP snooping is
required to disallow the multicast traffic on those network interfaces that are not participating in
AirPrint's Bonjour multicast discovery.

The wireless network switches must not be interconnected for redundancy. This results in a Layer 2
switching loop.

2.3.2 Network Requirements

+ Wireless network with no interconnection

¢ [P Multicast network (IP Multicast must be enabled on network devices such as routers and
switches)
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3.1

3.1.1

Installing iPrint Appliance

Before installing iPrint Appliance, see Appendix E, “Best Practices,” on page 113 to ensure a seamless
experience with iPrint Appliance.

¢ Section 3.1, “Downloading and Configuring iPrint Appliance,” on page 17

Downloading and Configuring iPrint Appliance

¢ Section 3.1.1, “Downloading the iPrint Appliance and Configuring the Virtual Environment,” on
page 17
¢ Section 3.1.2, “Installing iPrint Appliance,” on page 21

Downloading the iPrint Appliance and Configuring the Virtual
Environment

You must download the iPrint appliance and configure the virtual environment where you plan to
run the appliance. This includes configuring system resources and so forth.

The process of downloading the iPrint appliance and configuring the virtual environment differs,
depending on which virtual environment you plan to use to run the iPrint appliance.

¢ “VMware Configuration” on page 17

+ “Xen Configuration” on page 18

¢ “Hyper-V Configuration” on page 20

VMware Configuration

1 Download the iPrint software (iPrint.x86_64-version.ovf.zip) to your management
workstation.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (http://
download.novell.com/Download?buildid=9xcn1vXns5A~) on the Novell Downloads page
(http://download.novell.com).

2 Extract the iPrint_x86_64-version.ovf.zip file on your management workstation so that the
iPrint-version file folder appears.

3 In the vSphere client, click File > Deploy OVF Template.

NOTE: If the virtualization software you are using does not support ovf, you must convert the
-ovf file to .vmx using the VMware OVF Tool available on the VMware Website.

4 Browse to and select the .ovT file in the iPrint-version file folder.
5 Click Next.
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18

6
7
8
9
10

11

12
13

Click Next again.

In the Name field, rename the iPrint appliance to a name of your choice, then click Next.
Click Next to accept the default for the disk format.

Click Finish.

(Optional) Create a separate VMware hard disk for the appliance. This is the location where you
will store your iPrint files.

10a In the vSphere client, right-click the virtual machine that you just created, and for which
you want to create secondary storage, then click Edit Settings.

The Virtual Machine Properties page is displayed.
10b On the Hardware tab, click Add.

The Add Hardware dialog box is displayed.
10c Select Hard Disk, then click Next.
10d Select Create a new virtual disk, then click Next.

10e In the Disk Size field, specify the amount of hard disk space that you want to allocate. The
default of 4 GB might not be sufficient except in a very limited testing environment.

10f Select a datastore, then click OK.

10g Click Next.

10h Click Finish.

Increase the amount of memory that VMware allocates for the iPrint appliance.

11a In the Virtual Machine Properties window, select Memory, then increase the setting to a
suitable size for your environment.

11b Click OK to exit the Virtual Machine Properties window.
Power on the appliance (virtual machine).

Continue with Section 3.1.2, “Installing iPrint Appliance,” on page 21.

Xen Configuration

1

ssh

Log in to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on
Linux:

-X root@host_ip_address

You must use the -X in the command in order to display the GUI installation program. The steps
in this section use the GUI installation program to configure the server.

Navigate to the /var/lib/xen/images directory on the host server.
Create a new directory inside the images directory where you can download the iPrint software.

The name of this directory must be the same as the name that you plan to use for your iPrint
virtual appliance. For example, if you plan to name the iPrint appliance iPrintl, the name of
this new directory must also be iPrintl.

Change to the directory that you just created. For example, /var/lib/xen/images/iPrintl.

5 Download the iPrint software (iPrint.x86_64-version.xen.tar.gz) to the current directory

on the host server. For example: /var/lib/xen/images/iPrintl
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You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (http://
download.novell.com/Download?buildid=9xcn1vXns5A~) on the Novell Downloads page
(http://download.novell.com).

6 Untar the iPrint.x86_64-version.xen.tar.gz file in the directory where you downloaded it.

You can use the following command to untar the file:

tar -Sxvzf iPrint.x86_64-version.xen.tar.gz

A iPrint-version directory is created, which contains a . raw file that you will use to run the
virtual image. This process can take a few minutes.

7 From the host server, run the following command to launch the GUI configuration menu:
vm-install
The Create a Virtual Machine wizard is displayed.
8 Click Forward.
9 Select I have a disk or disk image with an installed operating system, then click Forward.
10 Leave SUSE Linux Enterprise Server 11 selected, then click Forward.

11 Rename the virtual machine by clicking Name of Virtual Machine, then specifying a new name in
the Name field. Then click Apply. For example, iPrintl.

12 Configure the amount of memory and number of CPUs that Xen allocates for the iPrint
appliance.

12a On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of available memory that is available on the host
server.

Initial Memory: 4 GB is the recommended minimum amount of memory.
Maximum Memory: Set this to the same value that you set for Initial Memory.
Available Processors: Displays the number of available processors on the host server.

12b Click Apply.

13 Configure the bootable disk image:

13a On the Summary page, click Disks.

13b Click Harddisk.

13c On the Virtual Disk page, specify the following information:
Source: Click Browse, then browse to the . raw file that you untared in Step 6.
Protocol: Select file:.
Size (GB): The default size is 40.1 GB. This cannot be changed.
Create Sparse Image File: This option is not available.
Read-Only Access: Do not select this option.

13d Click OK.

14 (Optional) Create a separate Xen hard disk. You must add a hard disk to the virtual machine
before you choose this option. If you have not already added a hard disk, click Power Off Virtual
Machine, modify the virtual machine settings to add a hard disk, then power on the virtual
machine.
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15
16

17

NOTE: If you do not add a hard disk to the virtual machine, then iPrint Appliance is installed on
the default partition. The default partition is /sda.

14a On the Disks page, click Harddisk.
14b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the . raw file that will be created when
the virtual machine is created. If desired, you can rename the disk in the source field from
diskO to a name of your choosing.

Size (GB): Specify the amount of hard disk space that you want to allocate. The default of 4
GB might not be sufficient except in a very limited testing environment.

Click OK > Apply.

Click OK to save your changes and to create and power on the virtual machine.

IMPORTANT: Do not power on the appliance until you have created a separate Xen hard disk
for the appliance, as described in Step 14.

Continue with Section 3.1.2, “Installing iPrint Appliance,” on page 21.

Hyper-V Configuration

1

10

11

Log in to the host server either locally or from a remote workstation.
You can use Windows Remote Desktop to log in to the host server from a remote workstation.

Create a new directory in the location where you want each virtual machine to reside (for
example, C:\Users\Public\Documents\Hyper-V\Virtual Hard Disks). In a later step, you
will download the iPrint software to this directory.

As a best practice, give this directory the same name as the name that you plan to use for your
iPrint virtual appliance. For example, if you plan to name the iPrint appliance iPrintl, the
name of this new directory should also be iPrintl.

Download the iPrint software (iPrint.x86_64-version.vhd.zip) to the directory on the host
server that you created in Step 2.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (http://
download.novell.com/Download?buildid=9xcn1vXns5A~) on the Novell Downloads page
(http://download.novell.com).

Extract the iPrint.x86_64-version.vhd.zip file to the directory on the host server that you
created in Step 2.

Open the Hyper-V Manager.

In Hyper-V Manager, right-click the disk name in the Action Pane in the left-hand column of the
Hyper-V Manager window. This is the disk where you want to create the new virtual machine.
Then click New > Virtual Machine.

The New Virtual Machine Wizard is displayed.

Review the Before You Begin page, then click Next.

In the Name field, specify a name for the new virtual machine. For example, iPrintl.
Click Next.

In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual
machine. 4 GB is the recommended minimum for a iPrint.

Click Next.
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On the Configure Networking page, select the networking card of your choice, then click Next.
Configure the bootable disk image:

13a On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then browse
to the .vhd file that was in the downloaded .zip file that you extracted in Step 4.

13b Click Open to select the file, then click Next.
Click Finish.

(Optional) Create a separate Hyper-V hard disk for the appliance. You must add a hard disk to
the virtual machine before you choose this option. If you have not already added a hard disk,
click Power Off Virtual Machine, modify the virtual machine settings to add a hard disk, then
power on the virtual machine.

NOTE: If you do not add a hard disk to the virtual machine, then iPrint Appliance is installed on
the default partition. The default partition is /sda.

15a In Hyper-V Manager, right-click the disk that you just created, then click Settings.

15b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

15c Select Virtual hard disk, then click New.

15d Review the Before You Begin page, then click Next.

15e On the Choose Disk Format page, select VHD, then click Next.

15f On the Choose Disk Type page, select Fixed size, then click Next.

15g On the Specify Name and Location page, specify the following information, then click Next:
Name: Specify a name for the hard disk. For example, iPrintDisk2.
Location: Specify the location where you want the hard drive to be located.

On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size for the
hard disk. The default of 4 GB might not be sufficient except in a very limited testing
environment.

Click Next.

Review the summary information, then click Finish.
Click Apply > OK.

Right-click the virtual machine, then click Start.

IMPORTANT: Do not start the appliance until you have created a separate Hyper-V hard disk
for the appliance, as described in Step 15.

Right-click the virtual machine, then click Connect.

Continue with Section 3.1.2, “Installing iPrint Appliance,” on page 21.

3.1.2 Installing iPrint Appliance

1

2

3

After you have downloaded the iPrint appliance, configured the virtual environment, and
powered on the appliance, click the Console tab.

After the appliance starts, select your preferred keyboard layout in the Keyboard Language drop-
down, then accept the license agreement. You can change the language the license agreement is
displayed in from the License Language drop-down.

The iPrint Appliance Configuration page is displayed.
On the configuration page, specify the following network information:

Root password and confirmation: The root password for your iPrint appliance.
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Vaadmin password and confirmation: The preferred user to use when logging in to the
appliance.

Hostname: The fully qualified DNS host name associated with the appliance’s IP address. For
example, myiPrint. mynetwork.example.com.

IP Address: The static IP address for the appliance. For example, 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP address. For example,
255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your iPrint virtual appliance is
located. For example, 172.17.2.254.

DNS Servers: The IP address of a primary DNS server for your network. For example,
172.17.1.1.

NTP Server: The IP address or DNS name of the reliable external Network Time Protocol (NTP)
server your OES server uses. For example, time.example.com.

For the best results, set up NTP in accordance with the VMware best practices guidelines (http://
kb.vmware.com/selfservice/microsites/
search.do?language=en_US&cmd=displayKCé&externalld=1006427).

Region: Your local region.
Time Zone: Your local time zone.
Click Next.

5 Select the data storage location.

¢ Hard Disk (recommended): You must add a hard disk to the virtual machine before you
choose this option. If you have not already added a hard disk, click Power Off Virtual
Machine, modify the virtual machine settings to add a hard disk, then power on the virtual
machine.

NOTE: If you do not add a hard disk to the virtual machine, then iPrint Appliance is
installed on the default partition. The default partition is /sda.

¢ Remote NFS: You must export the remote directory before you choose this option.

IMPORTANT: If you want to configure iPrint Appliance using the Remote NFS option, you
must ensure that the NFS share is mounted on OES or Netware, and configure the NFS
share with the rights rw,no_root_squash, fsid=0.

6 Click Next.
7 (Conditional) If you selected Hard Disk in Step 5, specify the following options, then click Next:

Hard Drive: Select the hard drive you are using.

If you created a secondary VMware hard disk for this appliance as described in Step 10, it is
automatically detected and sdb is displayed as the hard drive. Accept the defaults for the other
options on this page and skip to Step 8.

If you have not created a secondary VMware hard disk, you will notice a warning message. You
can change the settings, or you can choose to continue the installation anyway:.

Use an existing partition: Select this option to use an existing partition.
Create a new partition: Select this option to create a new partition.
Partition size: Specify the partition size.

Filesystem type: Specify the type of file system.

8 (Conditional) If you selected Remote NFS in Step 5, specify the following options:
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NFS Server Hostname: Specify the host name of the NFS server. Windows servers are not
supported.

Remote Directory: Specify the path to the remote directory.
Click Configure.

The iPrint Appliance installation process begins. A message stating, “The system is ready for
appliance configuration” is displayed. After the installation is complete, a URL and an IP

address to access the iPrint Appliance Management Console is displayed. Using a Web browser,

navigate to the Management Console URL.

NOTE: Ignore the WARNING message that is displayed in the command prompt.

The iPrint Appliance installation is now complete. You must configure iPrint Appliance before
you can start printing. Continue with Chapter 4, “Setting Up iPrint Appliance,” on page 25.
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Setting Up IPrint Appliance

You can configure iPrint Appliance through the iPrint Appliance Management Console (Novell iPrint
Appliance Administration).

¢ Section 4.1, “Methods of Setting Up iPrint Appliance,” on page 25

¢ Section 4.2, “Creating and Configuring Printers Using the Management Console,” on page 29

¢ Section 4.3, “Importing Printers from an Existing OES iPrint System or iPrint Appliance,” on
page 34

¢ Section 4.4, “Importing Users from an LDAP Source,” on page 39
¢ Section 4.5, “Line Printer Remote (LPR) Printing,” on page 39
¢ Section 4.6, “iPrint Appliance Configuration Complete,” on page 39

4.1 Methods of Setting Up iPrint Appliance

You can set up iPrint Appliance as a new copy, or you can upgrade from an earlier version.
1 On a Web browser, use either the DNS name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. To avoid the security warning prompt every time you access the iPrint Appliance
Management Console, you can add the certificate to the trusted certificates list on your browser.

2 Specify vaadmin or root as the user name.
3 Specify the password, then click Log in.
The Management Console page is displayed.
4 Click iPrint Appliance Configuration.
The iPrint Initial Configuration Wizard window is displayed.
5 Select New or Upgrade, then click Next.

¢ Section 4.1.1, “New,” on page 25
¢ Section 4.1.2, “Upgrade,” on page 27

411 New

1 Specify the following information:
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Table 4-1 iPrint Initial Configuration Wizard

General Authentication Realm: Specify the authentication
domain. This is used to help you identify the domain
that you are logging in to when accessing iPrint
services. For example, PSM Status page.

DNS for Print Manager: Specify the DNS name in the
format displayed in the box. It is recommended that
you do not use the DNS name of iPrint Appliance.
Specify a DNS name that follows the Print Manager.
This provides the flexibility to move the Print Manager
to a different server. The DNS name is also known as
a CNAME record. It is a DNS name tied to a service,
rather than a server. The DNS name must resolve to
the IP address of the Appliance. If you choose to
specify a CNAME record, ensure that the chosen
name resolves to the IP address of iPrint Appliance.

Embedded Data Store Administrator Username: The administrator account
user name is pre-populated in the following format:
cn=admin,o=iPrintAppliance. This field is not
editable.

Administrator Password: Specify the password for
the administrator account. Administrator password is
the eDirectory administrator Password. It is used for
eDirectory and iManager.

Re-type Password: Specify the password again to

confirm.

Driver Store Local: If you want to use a local Driver Store, select
Local. You can manage the Local Driver Store using
iManager.

Remote: If you have an existing Driver Store
configured with another iPrint Appliance or OES
server, you can use that Driver Store by selecting the
Remote option, then specifying the DNS Name/
Address, User name and Password of the server
containing the Driver Store.

IMPORTANT: You can set up the Remote Driver Store
only during the initial configuration of iPrint Appliance.

NOTE: Specify the credentials of the root account of
the server where the Driver Store resides.

NOTE: If you configure a Remote Driver Store, you cannot manage it through the iPrint
Appliance iManager.
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4.1.2

iPrint Initial Configuration Wizard

General
Authentication Realm: PR

DHS for Print Manager: virtualname.yourcompany.com

Embedded Data Store
Administrator Username: cn=admin,o=iPrintAppliance
Administrator Password:

Re-type Password:

Driver Store

@ Local
' Remote (applies to all drivers)

Previous Finish

2 Click Finish.

After configuring iPrint Appliance, you must create printers. You can create printers using the
Management Console. If you have an existing iPrint Appliance or OES iPrint system, you can also
import printers. To create printers, see Section 4.2, “Creating and Configuring Printers Using the
Management Console,” on page 29.

Upgrade

You can use the Upgrade option in two scenarios:

¢ Upgrading iPrint Appliance from an earlier version

¢ Importing the configuration settings from an existing copy of iPrint Appliance

When you select the Upgrade option, you are prompted for the configuration file iprintconfig.zip.
To create a configuration file, you must export the configuration information from an existing copy of

iPrint Appliance.

Setting Up iPrint Appliance
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IMPORTANT: If you want to use an external disk to upgrade iPrint Appliance, you must add the
virtual machine hard disk of the older version of iPrint Appliance to the new version, navigate to the
DataStore location, then select the vmdk file of the older version of iPrint Appliance.

Exporting the Configuration File

1 On a Web browser, use either the DNS name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console.

2 Specify vaadmin or root as the user name.
3 Specify the password.
The Management Console page is displayed.
4 Click the iPrint Appliance Configuration icon.
5 Under Administration, click Export Configuration.

6 Specity the eDirectory administrator Password, then click Export.

NOTE: eDirectory administrator Password is the password that you use for the administrator
account of iPrint Appliance when using iManager.

The iprintconfig.zip file is created. This is the backup file. The backup file contains the
configuration information.

NOTE: Log files are not backed up when exporting the configuration file.

Upgrading iPrint Appliance

When upgrading to a new version of iPrint Appliance from an older version, ensure that the newly
deployed version of iPrint Appliance has the same network configuration, passwords, and time zone
as that of the older version of iPrint Appliance from which you exported the iprintconfig.zip
configuration file.

1 On a Web browser, use either the DNS name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console.

2 Specify vaadmin or root as the user name.
3 Specify the password.
The Management Console page is displayed.
4 Click iPrint Appliance Configuration.
The iPrint Initial Configuration Wizard window is displayed.
5 Select Upgrade, then click Next.

6 In the File option, click Choose File, then select the configuration file exported from a previous
copy of iPrint Appliance.
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4.2

421

iPrint Initial Configuration Wizard

Browise for, and select the configuration file exported from an older iPrint
appliance (i.e. iprintconfig.zip). You must provide the same password for the
eDirectory administrator (cn=admin,o=iPrintappliance) that was used when the
zip file was created.

File: Choose File | Mo file chosen

eDirectory Password:

Previous Finish

7 Specify the eDirectory Password.

NOTE: eDirectory Password is the password that you specified when exporting the configuration
file from the previous copy of iPrint Appliance.

8 Click Finish.

After upgrading iPrint Appliance, you must copy the license file from the older version of iPrint
Appliance to the newly installed version. For information on updating your license, see Chapter 10,
“iPrint Appliance License Information,” on page 77.

Creating and Configuring Printers Using the Management
Console

Before configuring the printer, you must create printers on iPrint Appliance by using iManager.

Creating Printers

1 On the iPrint Appliance Management Console page, select the iPrint Printer Configuration
(iManager) tool to connect to iManager.

2 Log in to iManager using the eDirectory admin credentials of iPrint Appliance.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. If you add the certificate to the trusted certificates list, the security warning is not
displayed.

3 Click iPrint > Create Printer.

4 Configure the iManager security certificate. To create a printer on iPrint Appliance, you must
accept the security certificate for the first time.

4a When you specify values in the Create Printer page for the first time, the values are ignored.
To accept the security certificate, fill in the required fields with the first printer that you
want to create, then click Next.

4b Click iPrint Certificate Manager when an error is generated.
4c Select the Trust the above certificate option, then click OK.

4d Click OK to complete the security certificate configuration.
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5 Click iPrint > Create Printer.
6 Specify the Target printer details.

Printer Name: Defines the label by which the new printer is identified. You can include
uppercase and lowercase letters, numbers, spaces, and underscore in the label. Do not use any
other characters.

Container Name: The eDirectory container where the printer reference resides. By default, the
value is “iPrintAppliance”. We do not recommend changing the default value.

Print Manager name: The name of the Print Manager that handles the incoming print jobs.

DNS name or IP address: The IP address of a printer uniquely identifies it on the network and
allows other networked machines to communicate with it. A DNS name can also be applied to
the printer, which can be translated into the printer's IP address.

Specify the IP address (v4) or the DNS name of the target printer.

Location: Indicates the printer's location. The value of this field is displayed when selecting a
printer.

Description: Describes the printer. The value of this field is displayed when selecting a printer.

LPR Printer Name: Specify an LPR printer name. If the LPR protocol is selected, other optional
parameters can also be specified. With most modern printers, the name can be set to
PASSTHROUGH. With some older printers (1990's & prior), there might be a different printer
name.

RAW Port Number: If the RAW protocol is selected, a port number is required. Most printers are
configured, by default, to use port 9100 for RAW protocol communications.

iPrint Appliance supports printer communications using either the Line Printer Remote (LPR) or
RAW protocols.

The LPR protocol is the most common printing protocol and is generally more flexible than the
RAW protocol. A printer that supports the LPR protocol is sometimes referred to as a TCP/IP
printer. The LPR protocol has limited error reporting capabilities, which is often limited to
“Printer Error” with no details.

The RAW protocol is often the default protocol on non-Windows systems. Most printers that
support the RAW protocol use port 9100. The LPR protocol can generally be substituted for the
RAW protocol if the RAW protocol does not respond to a print job.

7 Click Next.
8 Specify the drivers for the printer.

iPrint Appliance supports both driver and driverless printing. For mobile device printing,
drivers are not required. The selectable drivers for each operating system are available in the
Novell iPrint Appliance Driver Store.

9 To re-edit the printer-specific options after the new printer has been created, click Modify. To
create another printer, click Repeat Task. To continue, click OK.

NOTE: In iManager, you might see a Partition and Replicas option. This feature is not required for
iPrint Appliance, so it is not supported. We recommend that you do not use it on the iPrint
Appliance eDirectory.

IMPORTANT: In iManager, do not create or delete Print Manager objects. Always use the
default Print Manager object.

For more information on managing your print system, including creating and deleting printers,
managing Printer Agents, and creating Printer Driver Profiles using iManager, see the Managing
Printers section in the OES 11 iPrint Administration Guide.
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4.2.2 Creating Secure Printers

With iPrint Appliance, you can set access controls for your print system, and also use SSL/TLS to
secure your printing environment. For more information, see the Setting Up a Secure Printing
Environment section in the OES 11 iPrint Administration Guide.

4.2.3 Configuring Printers

After creating printers, you must configure them using the iPrint Management Console.
1 On a Web browser, use either the DNS name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. If you add the certificate to the trusted certificates list, the security warning is not
displayed.

2 Inthe Novell iPrint Appliance Administration login page, enter the user name as vaadmin, enter
the password that you specified for vaadmin, then click Log in.

3 Click the iPrint Appliance Configuration icon.
4 Under Administration, click Printers.

The Printers screen lists all printers created with iManager that are currently managed by iPrint
Appliance. You can enable the printers for Mobile, AirPrint, and Email printing for iPrint
Appliance, as well as the desktop email client.

root | Home | Logout

Prviers 2
Hobile Configuration ik bl Printers
Printars AirPr = Moble -
Renderers Name AlPrt™  Mobke Email Securs  Location Deseription
= printer_normal &th flaor rarmal printer T
Senices =
= xerox_printer &th floor Xerox printer i
Exporl Configuration
& g = secure_printer Bth flaor secure printer
LDAF Impart = raw printer 8th feor Raw prnter
License = audtprinter Eth floor audit printer
= printer_lpr &th floor lpr printer
= printer_direct Sth floar direct print

5 Select the printer that you want to configure. The AirPrint, Mobile and Configure drop-down
menus are activated. You can choose multiple printers at a time by holding the Ctrl key.

6 To configure the selected printer(s) for AirPrint, click the AirPrint drop-down menu, then click

Enable Advertising.
reot | Home | Logout
roners a
Mabile Configuration Available Printers
Printers AirPrint™ = Mabie - Configure -
Renderers Enable Advertisng ArPrnt™ Mobie Email Secure  Location Description
_ | ‘ o o sth floar normal printer -
Senices L i =
3=, xerox_printer 4 o &th floar Xerox printes T
Ea CepTpuEton &, secure_printer o v v 4 Sth floor SECUME printer
LDAP Import =, raw prnter W o th foar Raw printer
License =, audt prnter v o &th floor audit printer
=, printer_lpr v o &th floor Ipr printer
=, printer_direct 4 o ath floor direct print
= printer_1 4 o
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The selected printer is now advertised by the Novell iPrint Mobile Appliance.

Available Printers

&irPrint™ = Mobde » Configure »

Hame AirPrint™ Mobie Emai Secure | Location Descrphion
= printer_normal L th floor normal printer

7 To configure the printers for Mobile and Email printing, click the Mobile drop-down menu, then
select Enable.

Available Printers
AirPrint™ = Mobie = Confipure -
[l

N Enable AirPrint™ Mobde Email Secure | Location Description
= I 4 8th floor neemal printer

= xerox_printer gth floor Xerox peiner

8 The selected printer is enabled for Mobile and Email printing.

Available Printers

Print™ = Moble = Car e
Hame Arfnnt™ Wobde Email Secure | Location Description
= printer_normal v 4 £ v 4 gth floor normal printer

9 Each printer managed by iPrint Appliance can be configured for a private email account. To
configure the selected printer with a private email account, select a printer, click the Configure
drop-down menu, then click Private Email Settings.

Available Printers
ArPrint™ = Mobils > Configure ~

Name I Private Emal Settings jrlnhile Ermai Secure | Location Descriglion
&= printer_narmal v v o &th floor normal printer

10 Select Enable private email-based printing, then specify the Account and Server information.
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Private Email Settings

£ Warning. Changing values on this page wil restart the
Mobile Server which an cause exsting print job loss.

¥ Enable private ema
Account
Ermzil Addrese:
Lis@rmamme:
Password:

Retype Password:

Server

Incoming Mail Server:

Outgoing Mzl Server;

Arcess Method:

i-based printing

sampleprinter@novell.com
sampleprinter
o o o o

imap.novell,com
sirtp. novel.com

MAP »

Ok Cancel

Account -

Server .

Email Address: Specify the full email address of the mailbox to be polled for the
print jobs. When an email-based job arrives, the print job is processed to the
printer. For example, iprint@example.com.

Username: Specify the user name to be used by iPrint Appliance to log in to the
email server to access the private printer email account. For example, iprint.

Password: Specify the password for iPrint Appliance to log in to the email
server to access the private printer email account.

Retype Password: Confirm the account password.

Incoming Mail Server: Specify the address of the incoming email server for the
email account. For example, imap.example.com.

Outgoing Mail Server: Specify the address of the outgoing email server for the
email account. For example, smtp.example.com. Your email server must
support the SMTP protocol.

Access Method: iPrint Appliance supports two different protocols to poll for
incoming print jobs. Select POP or IMAP depending on the protocol your email
server supports.

When configured for p

rivate email printing, iPrint Appliance becomes a client to an email

server. The printer's account inbox is polled for incoming print jobs that are routed to the printer.

NOTE: Ensure that the private email account is established and functional before associating it

with a printer.

11 Click OK.
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4.3

43.1

4.3.2

The selected printer is now accessible for email-based printing, using the private email address.

"_"u.:-.Fln-_:'- n

Available Printers
Hame AirPrint™ Makbile Email Secure | Location Descriplion
= printer_direct w s Gth flmor drect print

Importing Printers from an Existing OES iPrint System or
iPrint Appliance

If you have an existing OES iPrint system or iPrint Appliance, you can import printers by following
the procedure below.

Prerequisites

Before starting the import process, you must connect to iPrint Appliance using a secure shell or
terminal.

If using Windows:

1 Download and install an X-server such as MobaXterm.

NOTE: It is recommended that you use MobaXterm. If you use other X-servers (for example, X-
ming), you might not be able to populate the required fields on the migration tool.

2 Launch a Secure Shell Client, then connect to iPrint Appliance by using the IP address.
3 Run the command export DISPLAY=<localsystemlPaddress>:0.0.

If using Linux or Mac:

1 Launch the terminal, then run the command ssh -X <iPrintAppliancelPaddress>.

Printer Import

1 Launch the Migration Tool on the iPrint Appliance server by using the command miggui.
The Migration Interface is displayed.

Authenticate to the source and iPrint Appliance servers.

Select Consolidate as the migration type.

Click Add.

Select Novell iPrint, then click OK.

If you see a Do you want to configure the Novell iPrint service now? message, click Yes.

o 01 A W N

The iPrint Migration window is displayed.
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iPrint Migrationi(on wgp-print-231)

[_Print Options | other Options |

Print Managers

Select printers from Source printers list to migrate,

Source Print Manager : |

Target Print Manager :

||:n=print_manager,n=iprintappliance

[ oo |

[] eDirectory Server* :

Printer Objects

SOuUrce printers:

*In case the Target Server does not hold a ebirectory replica

[ "Printer with same name exists on Target cantext)

Select |

Printer Agents

Context

[ ]select Al Filter |

Create Target printer objects in:

() Context same as Source grinter context

® Target context: |

[ ] Do Mot Migrate Existing Target Printers

For mare informatiaon, refer to [Print Migration Best Practices Guide,

H @Qancel |

[»

4

7 Click Get Printers to select printer objects from the source Print Manager.

8 Configure the following parameters to proceed with the migration process:

Print Objects Parameter

Description

Print Managers Source Print Manager

Specify the active Print Manager on the source server. The
source Print Manager can be either an NDPS manager (for
NetWare 6.5) or iPrint Manager (for OES 1 and OES 2 Linux).
To go directly to a context of your choice, specify the context in
the search base and click Search. The objects in the specified
context are displayed.
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Print Objects

Parameter

Description

Target Print Manager

Printer Objects Source printers

Create target
printer objects
in

Select All

Filter

Context same as
source printer context

Target context

Do Not Migrate Existing
Target Printers

The Target Print Manager field is populated with the name of
the active Print Manager running on the target server. This field
is editable; you can also specify a different name for the active
Print Manager. To go directly to a context of your choice,
specify the context in the search base and click Search. The
objects in the specified context are displayed.

Click Get Printers to select printer objects from the source Print
Manager.

Click Get Printers to select printer objects from the source Print
Manager.

Displays all printers of the active Print Manager available on
the source server. The printers that already exist on the target
server are indicated by an asterisk (*).

Selects all the printers listed in the Printer Objects dialog box.

NOTE: When you apply a new filter or modify an existing filter
and click Select All, only printers that are displayed after
applying the filter are selected. When you manually select all
printers, the selected printers are migrated.

Specify the search pattern in the Filter field. This displays the
printers in the Printer Agents list. This field is case sensitive.

Select this option to use the same context as the source
printers on the target server.

This option is selected by default. It allows you to create source
printers under a different context on the target server. This
option does not maintain the context hierarchy of the source
printer.

To go directly to a context of your choice, specify the context in
the search base and click Search. The objects in the specified
context are displayed.

If the printer names on the source server match the printer
names on the target server, the target printer properties and
attributes are overwritten by the source printer properties and
attributes.

The printers that already exist on the target server are
represented by an asterisk (*).
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iPrint Migrationi(on wgp-print-231)

Print Options | Other Options | T
Source Driver Store
[ ] The Source Driver Store is not on the same Server as the Source Print Manager
IP Address/DMS Mame .
User Mame :
Fassward
Migrate the following additional source Print Brakers to the Target Driver 3tore:
IP Address/DMS Mame Braker volume Mame
Target Driver Store
Target Driver 5tore DM D
[] Target Driver Stare is remote
IF Address/DMS Mame :
ser Mame :
Password : i
Printer Drivers
Ciptions to Migrate Printer Drivers:
) Do Mot Migrate Printer Driver and association of the Printer Agents with the Driver.
) Migrate Printer Driver if the driver is not present in the Target Driver Store.
3 Migrate all Printer Drivers. T?’Ei mverwrites the Printer Driver an the Target Diriver Store.
Migrate drivers for the followitg platforms:
All =
Windows 93/98 =
Windows NT 4 —
Windows 2000
Windows XP - |
Press Ctri+ Click to select ar deselect more than one platform
Migrate Printer Driver Profiles. This owerwrites the existing Printer Driver Profiles
Migrate iPrint.ini file. Thiz overwrites the existing iPrint.ini file on Target
@ Help | [ ox | ‘ @Qancel
For mare informatiaon, refer to [Print Migration Best Practices Guide, |
Other Options Parameter Description
Source Driver  The Source Driver If the source Driver Store is running on a server different from
Store Store is not on the the source Print Manager's server, this check box is selected.
same server as the .
Source Print Manager ~ SPecify the IP address or the DNS Name and the root
password of the server on which the source Driver Store is
located.
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Other Options Parameter

Description

Target Driver
Store

Printer Drivers

Printer Driver
Profile

iPrint.ini File

Migrate the following
additional Source Print
Brokers to the Target
Driver Store

Target Driver Store is
remote

Do not Migrate Printer
Drivers and the
association of the
Printer Agents with the
Driver

Migrate Printer Driver if
the driver is not present
in the target Driver
Store

Migrate all Printer
Drivers. This overwrites
the Printer Driver on
the target Driver Store

Migrate Printer Driver
Profile

Migrate iPrint.ini File

This section lists the names and IP/DNS addresses of the
source Print Broker volumes that must be migrated to the target
Driver Store.

Click the plus button (+) and specify the IP address or the DNS
name of the Source Broker. Select the Source Broker volume

from the drop-down list and click OK. The list is populated with
the IP address or DNS name of the Source Broker and Broker
volume name. You can add multiple Source Brokers to the list.

To remove the Source Broker from the list, select the IP
address or DNS name and click the minus button (-). You can
remove one Broker at a time.

If the Driver Store is running on the remote server (other than
the target server), the Target Driver Store is remote check box
is enabled.

Specify the IP address or the DNS name of the remote server
and the root password of the remote server in the
corresponding entry fields.

Selecting this option ensures that printer drivers and the
association of Printer Agents with the drivers are not migrated.

Selecting this option migrates the printer drivers for the
selected driver platforms from the Select Driver Platforms to
Migrate list, if they are not present in the target Driver Store.
This also migrates all the associations of the Printer Agents
with the driver.

NOTE: The default driver platform selection is All.

Selecting this option overwrites the target drivers for the driver
platforms you have selected from the Select Driver Platforms to
Migrate list, if the driver names in the target Driver Store are the
same as the source Driver Store. This also migrates all the
associations of the Printer Agents with the driver.

NOTE: The default Driver Platform selection is All.

If the profiles are the same on the target server as the source
server, the target profiles are overwritten.

If you migrate printer agents from two or more print managers,
the IPrint. ini file on the target server is replaced by the
iPrint.ini file of the last source server.

NOTE: After migration, if the target server's iprint. ini fileis
overwritten by the source server's file, and if the target server's
iprint.ini file had new parameters that were erased, you
can restore them by copying the parameters manually from the
iprint._bak file. The iprint.bak file is a backup of the
target server's iprint. ini file. After migration, the
iprint.bak file is saved in the /var/opt/novel 1/
iprint/htdocs directory.
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4.4

4.5

4.6

9 Click Start to begin the migration process.

If you are prompted to save the project, click either Yes or No to proceed. If you save a project, the
next time you want to import printers, you can use the saved file to retrieve your preferences
instantly.

Importing Users from an LDAP Source

To set up iPrint Appliance, you must import users from your LDAP source. For information on how
to import users from an LDAP source, see Section 9.1.6, “LDAP Import,” on page 70.

Line Printer Remote (LPR) Printing

Line Printer Remote (LPR) Printing is a platform-independent printing protocol. UNIX, Macintosh,
and other LPR clients can print to iPrint printers through LPR.

To set up an iPrint printer to accept LPR print jobs, you must enable LPR/LPD printing for the printer.
For more information, see Configuring LPR Printers in the iPrint Linux Administration Guide.

IPrint Appliance Configuration Complete

iPrint Appliance configuration is now complete. You can use the Novell iPrint app to print. The app is
currently available on Android and iOS platforms. You can download the Novell iPrint app to your
device from Google’s Play Store or Apple’s App Store, by searching for Novell iPrint. For information
about configuring and using the mobile application, see the Novell iPrint 1.0.1 User Guide, or the Help
section of the app.

Microsoft Office and PDF formats are best rendered using iPrint Windows Renderer. The renderer
uses Microsoft Office and Adobe Acrobat Pro applications to convert documents to print-ready
formats. To install iPrint Windows Renderer, continue with Chapter 5, “iPrint Windows Renderer
Installation and Configuration,” on page 41.
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IPrint Windows Renderer Installation
and Configuration

For desktop quality printing for Microsoft Office and PDF documents, you must install iPrint
Windows Renderer on a Microsoft Windows 7 64-bit system.

*

*

*

Section 5.1, “Downloading iPrint Windows Renderer,” on page 41
Section 5.2, “Installing iPrint Windows Renderer,” on page 42
Section 5.3, “Assigning Log On as a Service Rights,” on page 42
Section 5.4, “Creating an Authentication Key,” on page 43

Section 5.5, “Configuring iPrint Windows Renderer for Microsoft Office or Adobe Acrobat,” on
page 43

Section 5.6, “Configuring iPrint Windows Renderer as a Local User,” on page 44
Section 5.7, “Configuring iPrint Windows Renderer as a Domain User,” on page 44

Section 5.8, “iPrint Windows Renderer Commands,” on page 45

5.1 Downloading iPrint Windows Renderer

1

On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Specify vaadmin as the user name.

3 Specity the password that you provided for vaadmin.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Administration, click Renderers.

6 Click the icon next to the Download remote rendering agent link in the upper-right corner of the

screen, to download the renderer.

root : Home | Logout
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5.2

5.3

NOTE: The iPrint Windows Renderer installation interface is not available in Slovak,
Hungarian, Netherlands Dutch, and Catalan languages.

Installing iPrint Windows Renderer

1 After you have downloaded the software, launch the iPrintRendererSetup.msi file to begin
the installation.

2 Follow the on-screen prompts to complete the installation procedure.

IMPORTANT: iPrint Appliance supports only PostScript printers by default. For non-PostScript
printers like PCL, or for printers that do not work with the default PostScript driver, you must install
the appropriate printer drivers. For more information, see Appendix D, “Printing Using Specific
Printer Drivers,” on page 111.

If you want to install or uninstall Adobe Acrobat X Pro on the Windows 7 machine, and if iPrint
Windows Renderer is already installed, you must stop the iPrint Windows Renderer service using
the command iprntrendcmd -q. If you do not stop the iPrint Windows Renderer service, you might
see a message that Microsoft Office applications are running, and you might not be able to proceed
with the installation or uninstallation.

Assigning Log On as a Service Rights

Before configuring iPrint Windows Renderer, you must assign the Log on as a service rights to the
account with which you want to set up the renderer, on the local machine.
1 Go to Start > Control Panel.

2 In the upper-right corner of the Control Panel window, click the View by drop-down menu, then
select Large icons.

Go to Administrative Tools > Local Security Policy.

In the left pane, double-click Local Policies.

Click User Rights Assignment.

In the right pane, under Policy, double-click Log on as a service.

Click Add User or Group.

Specify the user name in the Enter the object names to select box, then click Check Names.
Click OK after the user is displayed.

10 Click OK.

11 Click OK, then close the Local Security Policy window.

© 00 N o 0o~ W
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0.4

5.5

Creating an Authentication Key

For an external document renderer like iPrint Windows Renderer to connect to iPrint Appliance, an
Authentication Key is required.

To create an Authentication Key:

1 On a Web browser, specify either the DNS name or the IP address. For example, https://
10.0.0.1:9443 or http://iprint.example.com/admin.

2 Specify the Username and Password, then click Log in.

3 Click the iPrint Appliance Configuration icon.

4 Under Administration, click Mobile Configuration.

5 Under Renderer Options, specify an Authentication Key.
The Authentication Key can be a combination of a string of characters.

6 Click Save.

Configuring iPrint Windows Renderer for Microsoft Office
or Adobe Acrobat

You can configure iPrint Windows Renderer to render specific formats based on your print
requirements. If you do not have a need to print PDF documents, you can install only Microsoft
Office. Similarly, if you do not have a need to print Microsoft Office documents, then you can install
only Adobe Acrobat on the Windows 7 64-bit system.

If you are installing only one of either Microsoft Office or Adobe Acrobat, you must modify the
iPrintRenderer.conf file before starting the configuration process:

1 Launch the iPrintRenderer .conf file located at
C:\NDPS\Renderer\conf\iPrintRenderer.conf.

2 Comment out the format that is not applicable to your print environment. If you are installing
only Adobe Acrobat, comment all the Microsoft Office formats lines listed in the file. If you are
installing only Microsoft Office, comment the Adobe Acrobat line.

3 Save and close the file.
4 Restart the iPrntRendCmd service.
If iPrint Windows renderer was configured and registered before modifying the

iPrintRenderer.conf file, you must unregister the renderer by using the command iPrntRendCmd
-u, and re-register by using the command iPrntRendCmd -r for the changes to take effect.

If you want to uninstall either Microsoft Office or Adobe Acrobat, follow the same procedure of
modifying the iPrintRenderer.conf file. Ensure that you unregister and re-register the renderer
after uninstalling either software.
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5.6  Configuring iPrint Windows Renderer as a Local User

You must configure and register the renderer with the iPrint Appliance server to start accepting
rendering jobs.

1 Launch the command prompt in the Run as administrator mode.

2 Run the command iPrntRendCmd -c to configure the renderer, then follow the on-screen
instructions to install the printer driver specific to your printer.

When prompted for service configuration credentials, specify the credentials of an account with
Windows admin and Log on as a service rights.

The generic universal driver must be pre-installed or provided during the iPrint Windows
Renderer installation. The latest version of HP Universal Print Driver for Windows - PostScript
for Window 7 64-bit is highly recommended. You can download the HP driver from HP’s drivers
and software page.

3 Run the command iPrntRendCmd -r <iPrintAppliance DNS name or IP address>
<authentication key> to register the renderer.

NOTE: You can find the Authentication Key in the Management Console of iPrint Appliance by
going to iPrint Appliance Configuration > Mobile Configuration.

During renderer registration, a certificate window is displayed. Accept the certificate to
complete the registration.

4 After configuration and registration of the renderer, run the command iPrntRendCmd -s from
the installation directory to check the iPrint Rendering Service status.

5.7 Configuring iPrint Windows Renderer as a Domain User

To configure iPrint Windows Renderer as a domain user, you must use a domain user account. If you
do not have a domain user account, you must create one. For information on creating a domain user
account, see the article on how to Create a user account on the Microsoft support site.

After creating a Domain User account, you must assign Log on as a Service rights to the domain user.
For more information, see Section 5.3, “Assigning Log On as a Service Rights,” on page 42.

After adding the Log on as a Service rights to the Domain User account, you must configure and
register the renderer with the iPrint Appliance server to start accepting rendering jobs.

1 Launch the command prompt in the Run as administrator mode.

2 Run the command iPrntRendCmd -c to configure the renderer.

3 When prompted for a user name, specify the user name in the following format:
[domainname]\[username].

4 Run the command iPrntRendCmd -r <iPrintAppliance DNS name or IP address>
<authentication key> to register the renderer.

NOTE: You can find the Authentication Key in the Management Console of iPrint Appliance by
going to iPrint Appliance Configuration > Mobile Configuration.

During renderer registration, a certificate window is displayed. Accept the certificate to
complete the registration.

5 After configuration and registration of the renderer, run the command iPrntRendCmd -s from
the installation directory to check the iPrint Rendering Service status.
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5.8

IPrint Windows Renderer Commands

The iPrntRendCmd command that is used to configure iPrint Windows Renderer has the following

options:

Command Description

Shows the various available commands with their syntax.
Shows the current version of iPrint Windows Renderer.

Configures the iPrint Windows Renderer service and installs the printer drivers. When prompted
for service configuration credentials, specify the credentials of an account with Windows admin
rights.

Registers iPrint Windows Renderer with the iPrint Appliance server. To start accepting rendering
jobs, you must register the renderer with the iPrint Appliance server.

Un-registers iPrint Windows Renderer from the iPrint Appliance server. After un-registration, the
iPrint Windows Renderer stops accepting jobs from the iPrint Appliance server for conversion.
The iPrint Rendering service is running, but does not receive rendering jobs from the iPrint
Appliance server.

Tests the conversion locally.
Displays the status of iPrint Windows Rendering service.

Starts the iPrint Windows Rendering service. After registration, the rendering service starts
automatically.

Stops the iPrint Windows Rendering service.

Lists the iPrint Appliance registered with iPrint Windows Renderer.

iPrint Windows Renderer Installation and Configuration
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6.1

6.2

AirPrint through iPrint

AirPrint is a framework that facilitates driverless printing. The framework was invented by Apple
Inc. iOS applications (apps) that implement AirPrint technology allow users to send print jobs to
AirPrint enabled printers. With iPrint Appliance, you can “AirPrint enable” any iPrint printer.

This section describes the benefits and key features of AirPrint through iPrint:

¢ Section 6.1, “iOS Wireless Printer Discovery,” on page 47

¢ Section 6.2, “Multicast DNS,” on page 47

¢ Section 6.3, “AirPrint through iPrint,” on page 48

¢ Section 6.4, “Benefits,” on page 48

¢ Section 6.5, “Supported iOS Devices,” on page 48

¢ Section 6.6, “AirPrint Deployment Considerations in iPrint Appliance,” on page 48
¢ Section 6.7, “AirPrint Deployment Scenario in iPrint,” on page 48

¢ Section 6.8, “Enabling AirPrint through iPrint,” on page 50

¢ Section 6.9, “Disabling AirPrint through iPrint,” on page 50

¢ Section 6.10, “AirPrint Errors and Symptoms,” on page 50

I0S Wireless Printer Discovery

iOS devices have an inherent service discovery mechanism called Bonjour. Bonjour has the wireless
service identifying capability known as mDNS (multicast DNS). iPrint uses the Linux Avahi daemon
service to advertise iPrint printers to the iOS devices on a wireless network.

Multicast DNS

Domain Name Service provides translation from a Web address (starting with www) to the Internet
Protocol (IP) addresses. mDNS (Multicast DNS protocol) is a method of network neighborhood
resource discovery. mDNS forwards the DNS message to many endpoints on a network. Each device
connected to an mDNS enabled network sends out a message detailing its name, function, and
capabilities. On the receiving device, the information is stored so that it can route requests when an
application requests a service, such as printing.

mDNS is useful in wireless networks. By monitoring mDNS advertisements, clients can learn the
location of the service, then connect to it in the same way as any other service. mDNS transforms the
manual process of configuring IP addresses and port numbers that provides a zero configuration
experience where a user references the service using human-friendly types and names.
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6.3

6.4

6.5

6.6

6.7

AirPrint through iPrint

When iOS devices such as iPhone, iPad, and iPod touch connect to the wireless network, they are
automatically assigned an IP address. This opens an opportunity to exploit the IP network service for
printer discovery, and submit the print job. iOS devices convert Microsoft Office files, images, and
Web pages into PDF; construct an IPP print request; and send the print request to the AirPrint
enabled IPP printer. The AirPrint enabled IPP printer renders the PDF or image file into a printer-
specific language such as post script. The printer consumes this data and the document is printed.
This is called AirPrint.

Many printers are not compatible with AirPrint. iPrint hides the printer’s capabilities, and advertises
the printer as an AirPrint enabled printer. This allows iPrint to extend the enterprise print service into
the wireless network to exploit the iOS devices’ inherent print capability, and provides additional
advantages to consume iPrint features.

Benefits

AirPrint through iPrint offers significant benefits over other printing models:

¢ Any iPrint printer can be enabled for AirPrint regardless of the printer’s inherent AirPrint
support.

¢ AirPrint enabled printers are also listed in the iOS device.

¢ AirPrint enabled printers can make use of the iPrint server’s features.

Supported i0OS Devices

Supported iOS devices include iPhone, iPad, and iPod touch with iOS 5 and above.

NOTE: Secure printing to iPrint printers through AirPrint is supported only on iOS 6.x. It is not
supported on iOS 5.x.

AirPrint Deployment Considerations in iPrint Appliance

The mDNS protocol operates on service announcements and queries, which allow devices to
advertise specific applications, such as printing services. Each query or advertisement is sent to an
mDNS multicast address for delivery to all clients on the subnet. Apple's Bonjour protocol relies on
Multicast DNS (mDNS) operating at UDP port 5353. iOS devices listen for services on these reserved
group addresses:

¢ IPv4 Group address - 224.0.0.251

The addresses used by the mDNS protocol are link-local multicast addresses and are valid on the link
local domain. Hence, routers might have to be enabled, in order to forward the multicast
advertisement to various subnetworks.

AirPrint Deployment Scenario in iPrint

The deployment scenarios are confined to the wireless-based LAN network because iOS devices can
only communicate over the wireless medium for the printer discovery and print services. The
deployment scenario varies based on how wireless is configured in the organization. The preferred
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scenario is to deploy iPrint’s AirPrint mDNS services led by the router, which has the ability to route
the mDNS packets (link local Bonjour advertisement) into the various wireless sub networks in the
organization. See Figure 6-1.

6.7.1 Intra VLAN Configuration

Wireless routers span across multiple wired networks, and have hot spots on every network. The
mDNS service advertises printers on the wireless network, and the iOS device builds a list of
available print services by listening to these advertisements. AirPrint client's users can select a target
printer from the received list of advertised printers.

Figure 6-1 Logical Network Segment Configuration
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In this configuration, the mDNS advertisement is instantly injected into the network. In the above
configuration, printer 'A'" is visible to VLAN 100 wireless users, and printer 'B' is visible to VLAN200
wireless users. The printers are not visible across the VLANS.
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6.8 Enabling AirPrint through iPrint

To enable AirPrint through iPrint:

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Specify the user name and password, then click Log in.

3 Click iPrint Appliance Configuration.

4 Under Administration, click Printers.

5 Select a printer for which you want to enable AirPrint.
The AirPrint and Mobile drop-down menus are activated.

6 Click the AirPrint drop-down menu, then click Enable Advertising.

iPrint AirPrint is now enabled on the iPrint printer. You can print to an iPrint AirPrint enabled
printer from any iOS device.

6.9 Disabling AirPrint through iPrint

To disable AirPrint through iPrint:
1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.
Specify the user name and password, then click Log in.
Click iPrint Appliance Configuration.

Under Administration, click Printers.

a b~ W N

Select a printer for which you want to disable AirPrint.
The AirPrint and Mobile drop-down menus are activated.

6 Click the AirPrint drop-down menu, then click Disable Advertising.

IMPORTANT: If a printer is shut down or redirected to another printer, you must disable AirPrint
advertising. This ensures that users do not receive errors when trying to print to non-functional
printers.

6.10 AirPrint Errors and Symptoms

When using AirPrint, users might receive a few error messages, or notice symptoms that might
indicate issues with the printer or the network. The errors and symptoms are listed below, along with
the possible cause.

Table 6-1 AirPrint Error and Symptoms

Error/Symptom Possible Cause
The printer is paused iPrint output printer queue paused.
Check the printer for errors Network communication failed between iPrint

Appliance and printer, or iPrint printer is shut down.
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Error/Symptom Possible Cause

The printer is offline iPrint Appliance is not reachable.

iOS 5.x: An error occurred printing this document iPrint printer is deleted from PSM but still published as

AirPrint printer on the network.

iOS 6.x: The printer is no longer available

The printer is no longer available iPrint printer is shut down.

The printer job is continuously under processing Printer is redirected or not working.

Points to note:

*

If the printer's input queue is paused, jobs are queued at the device print queue. To view the
print queue on iOS devices, double-tap the Home button, then select the Print Centre app.

For photo printing, paper types such as 4x6 and LETTER are available only on iOS 6.0 and
above. When printing images on iOS 6., the paper type is displayed by default.

The duplex option is displayed on the job submission page by default on iOS 5.x. This behavior
is different from iOS 6.x and above. On iOS 6.x, the duplex option is displayed dynamically by
querying the printer for duplex availability status.

AirPrint might display messages regarding the status of the printer such as empty input tray or
printer jam, based on the status message from the printer's console. If the printer is in READY
state without any warning/error messages, AirPrint does not display any printer error messages
to the user.

Before enabling AirPrint, ensure that the iPrint Appliance DNS name is resolvable by the iOS
device.

If a printer is not functioning, disable advertising on that printer to ensure that the printer is not
displayed as an AirPrint printer, and users do not try printing to those printers.

iPrint Windows Renderer must be configured with iPrint Appliance to ensure that documents
render correctly when printing using AirPrint.
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1.1

Email Printing

iPrint Appliance contains an email printing feature. Using email printing, you can print documents
from any device capable of sending emails. You can print emails by specifying email printing
commands in the subject line of the email. You can also print documents by emailing them to your
printer as attachments.

When you enable email printing, the email address you provide becomes the global print email
address. You can also configure a printer for private email printing by providing a specific email
address to each printer.

NOTE: To enable private email printing, you must first enable the email printing feature.

The difference between global email printing and private email printing is:

¢ Global Email Printing: When you enable email printing, you are prompted to specify an email
address. This email address is the global print email address. When configured for email
printing, iPrint Appliance becomes a client to an email server. The global email account inbox is
polled for incoming print jobs, which are then routed to the intended printer.

¢ Private Email Printing: With private email printing, you can assign a specific email address to
each printer. When a user sends an email printing request, the print job is sent directly to the
printer. Users do not need to specify any print commands in the subject line of the email.

Email printing is not enabled by default. You can enable email printing through the Management
Console. You must create a unique email address for iPrint Appliance to receive and process print
requests.

WARNING: You must create an exclusive email account to be used for iPrint Appliance. If you
provide an existing email address (for example, your official email address), the iPrint Appliance
mobile server immediately starts processing all existing emails in the inbox, replies to every mail
with a response, then deletes all the received emails.

¢ Section 7.1, “Enabling Email Printing,” on page 53

¢ Section 7.2, “Email Printing Commands,” on page 55

Enabling Email Printing

1 On a Web browser, use either the DNS name or the IP address of iPrint Appliance to access the
Management Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Specify the user name and password, then click Log in.
Click iPrint Appliance Configuration.
Under Administration, click Mobile Configuration.
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Choose Enable email-based printing.

This email address is the global print email address.
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6 Specify the following information:

Email address: Specify the full email address that is used to queue global print jobs. The global
email address must be unique for each copy of iPrint Appliance that you deploy.

WARNING: You must create an exclusive email account to be used for iPrint Appliance. If you
provide an existing email address (for example, your official email address), the iPrint
Appliance mobile server immediately starts processing all existing emails in the inbox, replies to
every mail with a response, then deletes all the received emails.

Account Username: Specify the user name for iPrint Appliance to log in to the email server to
access the global email account. Account Username must be the user name of the email address
that you specified in the Email address field.

Account Password: Specify the password for iPrint Appliance to log in to the email server to
access the global email account.

Re-type Password: Specify the password again to confirm.

Incoming Mail Server: Specify the address of the incoming email server for the email account.
For example, imap.example.com.

Incoming Server Type: iPrint Appliance supports IMAP and POP for incoming print jobs. Select
the protocol that your email server supports.

Outgoing (SMTP) Mail Server: Specify the address of the outgoing email server for the email
account. For example, smtp.example.com.

Enable Mail-body Printing: With email-based printing, attachments are always printed. This
option allows the email message body to also be printed.

7 Click Save.

IMPORTANT: When using email printing, the print command in the subject line might trigger spam
filters. To avoid this issue, configure your email system to allow print-specific emails. Include the
approved print users in the spam filter of your email system to prevent unwanted print requests.

7.1.1 Enabling Private Email Printing

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the iPrint Appliance Configuration icon.
3 Under Administration, click Printers.
4 Select a printer, click the Configure drop-down menu, then click Private Email Settings.

5 Specify the following information, then click OK.

Account + Email Address: Specify the full email address of the mailbox to be polled for the
print jobs. When an email-based job arrives, the print job is processed to the
printer. For example, print@example.com.

* Username: Specify the user name to be used by iPrint Appliance to log in to the
email server to access the private printer email account. For example, iprint.

+ Password: Specify the password for iPrint Appliance to log in to the email
server to access the private printer email account.

+ Retype Password: Confirm the account password.
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1.2

7.2.1

Server + Incoming Mail Server: Specify the address of the incoming email server for the
email account. For example, imap.example.com.

+ Outgoing Mail Server: Specify the address of the outgoing email server for the
email account. For example, smtp.example.com.

+ Access Method: iPrint Appliance supports two different protocols to poll for
incoming print jobs. Select POP or IMAP depending on the protocol that your
email server supports.

Email Printing Commands

You can print the body of the email and the attachments by using a few simple print commands in
the subject line of your email.
¢ Section 7.2.1, “Basic Print Commands,” on page 55

¢ Section 7.2.2, “Additional Print Commands,” on page 56

Basic Print Commands

help

Provides information on email printing commands.

list printers
To get the names of the available printers, send an email to the iPrint server address (for
example, iprint@novell.com) with the subject line list printers.

print printer=<printer_name>

Prints your email and its attachments to the specified printer. For example, print
printer=hp#Test Mail.

If you print to a specific printer by using the printer’s email address, the print printer
command is ignored.
hold printer=<printer_name>

Queues your email along with its attachments and sends you the job ID as acknowledgement.

resume
Resumes the printing of a job that you put on hold. There are two ways to print a job on hold:
¢ Send an email with subject resume followed by the job ID. For example, resume 10
¢ Send an email with the original subject line prefixed with resume. For example,
resume#Test Mail
cancel
Cancels a job that you put on hold. There are two ways to cancel a job on hold:
¢ Send an email with subject cancel followed by the job ID. For example, cancel 10

¢ Send an email with the original subject line prefixed with cancel. For example,
cancel#Test Mail
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1.2.2

status
Displays the status of a job. There are two ways to check the status of a job:
¢ Send an email with subject status followed by the job ID. For example, status 10

¢ Send an email with the original subject line prefixed with status. For example,
status#Test Mail

move
Moves a job to a new printer. There are two ways to move a job to a new printer:

¢ Send an email with subject move, the job ID, and the name of the new printer. For example,
move 10 printer=<PrinterName>

¢ Send an email with the original subject line prefixed with move, the name of the new
printer, and #. For example, move printer=<PrinterName>#Test Mail

list jobs
Lists the details of the held jobs.

default printer
Displays the default printer.

default printer=<PrinterName>

Sets a particular printer as your default printer. After you set the default printer, you do not need
to include the printer name while printing to the default printer. You only need to use the print
command followed by the email subject. For example, print#Test Mail.

NOTE: If a printer name contains spaces, enclose the printer name within double (") or single ()
quotes. For example, print printer="HP PRINTER".

NOTE: To separate the email subject from the command, use #. For example, print
printer=hp#Test Mail.

Additional Print Commands

In addition to the basic print commands listed above, you can use these commands to refine your

printing:

portrait [portrait=yes/portrait=y (or) portrait=no/portrait=n]
Prints your email content in portrait orientation. For example, print printer=hp
portrait=y#Test Mail

landscape [landscape=yes/landscape=y (or) landscape=no/landscape=n]
Prints your email content in landscape orientation. For example, print printer=hp
landscape=y#Test Mail

color [color=yes/color=y (or) color=no/color=n]
Prints your email content in color. For example, print printer=hp landscape=y
color=y#Test Mail.

pages

Prints a given range of pages in your email. For example, the command print printer=hp
landscape=y color=y pages=1-3#Test Mail prints pages 1, 2, and 3.
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copies

Prints the specified number of copies of your email and its attachments. For example, the
command print printer=hp landscape=y color=y pages=1-3 copies=5#Test Mail prints
5 copies of pages 1, 2, and 3.

duplex [duplex=yes/duplex=y (or) duplex=no/duplex=n]

Prints your email and its attachments on both sides of the printing paper. For example, the
command print printer=hp landscape=y color=y pages=1-3 copies=5
duplex=y#TestMail prints 5 copies of pages 1, 2, and 3 in duplex mode.

media

Prints your email and its attachments with the specified paper type. The default paper type is
“LETTER.” You can change the default paper type by using the iPrint Appliance Management
Console. The other available print paper types are A3, A4, and other common paper types. For
example, the command print printer=hp landscape=y color=y pages=1-3 copies=5
duplex=y media=A3#Test Mail prints 5 copies of pages 1, 2, and 3 in duplex mode, on an A3
size paper.

mai Ibody [mai lbody=yes/mai Ibody=y (or) mai lbody=no/mai lbody=n]

Prints either your email and its attachments or only the attachments from your email without
the email body. For example, using the command print printer=hp landscape=y color=y
mai Ibody=n#Test Mail prints only the email attachments in landscape mode.

NOTE: If you do not specify any of the additional commands, your print job is carried out according
to the default preferences set by your administrator.

IMPORTANT: When printing to a specific printer using the printer’s private email address, you do
not need to specify the printer’s name in the command. You can also leave the subject line empty.
Printing is carried out according to the default print options set by the administrator.

However, you must specify the print command in the following scenarios:

¢ The administrator changes the subject_optional_for_printer_specific_emails to False in
the iPrint Appliance Server Configuration file located at /etc/opt/novell/iprintmobile/
conf/iprintmobile.conf.

¢ If you want to customize the print options, you must specify the print command, along with
the required print options. For example, print landscape=y color=y pages=1-3 copies=5
duplex=y media=A3#Test Mail.
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IPrint Appliance System Configuration

The Novell iPrint Appliance Management Console allows you to administer iPrint Appliance, and to

change configuration settings, such as administrative passwords, network settings, and certificate
settings.

To access the Appliance System Configuration page:

1 On a Web browser, specify either the DNS name or the IP address. For example, https://
10.0.0.1:9443 or http://iprint.example.com/admin.

2 Specify the Username and Password, then click Log in.
3 Click the Appliance System Configuration icon.

The Appliance System Configuration page displays the following options:

¢ Section 8.1, “Administrative Passwords,” on page 59

*

Section 8.2, “Network,” on page 60

*

Section 8.3, “Time,” on page 60

*

Section 8.4, “Digital Certificates,” on page 61

*

Section 8.5, “Ganglia Configuration,” on page 62

*

Section 8.6, “System Services,” on page 63

*

Section 8.7, “Firewall,” on page 64

*

Section 8.8, “Shutting Down and Restarting iPrint Appliance,” on page 64

*

Section 8.9, “Signing Out of iPrint Appliance,” on page 65

8.1 Administrative Passwords

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the Appliance System Configuration icon.

z

3 Click Administrative Passwords.
4 Specify new passwords for the root and vaadmin administrators.

If you are changing the root password, you must first specify the current root password.
5 Click Save.
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IMPORTANT: To change the eDirectory admin password, launch the terminal and run the
script iprint_edir_change_passwd.sh.

8.2 Network

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the Appliance System Configuration icon.

=

3 Click Network.
4 Change the IP and DNS configuration settings for your Novell appliance.

IMPORTANT: Do not change any settings on the Network page. iPrint Appliance 1.0.1 does not
support network settings changes after the initial iPrint Appliance configuration.

5 Click Save.

8.3 Time

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the Appliance System Configuration icon.

=

3 Click Time.

4 Change the time configuration options as necessary:
NTP Server: Specify the NTP server that you want to use for time synchronization.
Region: Select the region where your Novell Appliance is located.
Time Zone: Select the time zone where your Novell Appliance is located.

5 Click Save.
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8.4 Digital Certificates

The Novell Appliance ships with a self-signed digital certificate. Instead of using this self-signed
certificate, you should use a trusted server certificate that is signed by a trusted certificate authority
(CA) such as VeriSign or Equifax.

The certificate works for both the Novell Appliance and the iPrint software (ports 9443 and 8443).
You do not need to update your certificate when you update the iPrint Appliance software.

Complete the following sections to change the digital certificate for your Novell Appliance. You can
use the digital certificate tool to create your own certificate and then have it signed by a CA, or you
can use an existing certificate and key pair if you have one that you want to use.

¢ Section 8.4.1, “Getting Your Certificate Officially Signed,” on page 61

¢ Section 8.4.2, “Using an Existing Certificate and Key Pair,” on page 61

¢ Section 8.4.3, “Activating the Certificate,” on page 62

¢ Section 8.4.4, “Managing Certificates,” on page 62

8.4.1 Getting Your Certificate Officially Signed

1 On the Digital Certificates page, select the certificate that you just created, then click File >
Certificate Requests > Generate CSR.

2 Complete the process of emailing your digital certificate to a certificate authority (CA), such as
Verisign.

The CA takes your Certificate Signing Request (CSR) and generates an official certificate based
on the information in the CSR. The CA then mails the new certificate and certificate chain back
to you.

3 After you have received the official certificate and certificate chain from the CA:

3a Revisit the Digital Certificates page by clicking Digital Certificates from the Novell
Appliance.

3b Click File > Import > Trusted Certificate. Browse and select the trusted certificate chain that
you received from the CA, then click OK.

3c Select the self-signed certificate, then click File > Certification Request > Import CA Reply.
3d Browse to and upload the official certificate to be used to update the certificate information.

On the Digital Certificates page, the name in the Issuer column for your certificate changes
to the name of the CA that stamped your certificate.

4 Activate the certificate, as described in Section 8.4.3, “Activating the Certificate,” on page 62.

8.4.2 Using an Existing Certificate and Key Pair

When you use an existing certificate and key pair, use a .P12 key pair format.

1 Go to the Digital Certificates page by clicking Digital Certificates from the Novell Appliance.
2 On the Digital Certificates page, in the Key Store drop-down menu, select JVM Certificates.
3 Click File > Import > Trusted Certificate. Browse and select your existing certificate, then click OK.

4 Click File > Import > Trusted Certificate. Browse and select your existing certificate chain for the
certificate that you selected in Step 3, then click OK.
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8.4.3

8.4.4

8.5

5 Click File > Import > Key Pair, then browse to and select your .P12 key pair file, specify your
password if needed, then click OK.

6 Continue with Section 8.4.3, “Activating the Certificate,” on page 62.

Activating the Certificate

1 On the Digital Certificates page, in the Key Store drop-down menu, select Web Application
Certificates.

2 Select the certificate that you want to make active, click Set as Active, then click Yes.

3 Verify that the certificate and the certificate chain were created correctly by selecting the
certificate, then clicking View Info.

NOTE: When you activate a certificate, the Set as Active button might still be enabled for that
certificate. You can ignore it, as it does not affect the certificate activation.

Managing Certificates

All certificates that are included with the IBM Java package that is bundled with the version of SLES
that iPrint Appliance ships with, are installed when you install iPrint Appliance.

You can use the Digital Certificates tool on the iPrint Appliance to remove certificates that are not
used by your organization, if you are concerned about keeping them.

Also, you can use the Digital Certificates tool on the iPrint Appliance to maintain the certificate store
by removing certificates that have expired and then installing new certificates as needed, according
to your organization’s security policies.

To access the Digital Certificates tool:
1 Click Digital Certificates from the Novell Appliance.

iPrint Appliance uses only the certificates that relate to LDAP and SMTP. In the Key Store drop-down
menu, under Web Application Certificates, a self-signed certificate is displayed. This certificate is
required for iPrint Appliance, and must not be deleted.

In the Key Store drop-down menu, under JVM Certificates, you can delete all the certificates except the
edir_root_ca certificate, and any other LDAP or SMTP certificates that you might have imported.

Ganglia Configuration

Ganglia is a scalable, distributed monitoring system that allows you to gather important information
about your iPrint Appliance system.

1 On a Web browser, use either the DNS name or the IP’ address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the Appliance System Configuration icon.

z
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8.6

8.6.1

8.6.2

3
4

5

For more information about how to use Ganglia monitoring with iPrint Appliance, see Chapter 12,

Click Ganglia Configuration.

As necessary, change the following Ganglia configuration options:

Enable the Web interface to run on this machine: Select this option to allow the Ganglia Web

Interface to run on the same machine as iPrint Appliance.

Enable Ganglia Monitoring: Select this option to enable Ganglia to monitor iPrint Appliance.

Multicast Mode: Select this option to send monitoring information to multiple destinations.

Unicast Mode: Select this option to send monitoring information to a single destination.

Publish to: Specify the URL where Ganglia sends monitoring information when it is running in

Unicast mode.
Click Save.

“Monitoring iPrint Appliance Performance with Ganglia,” on page 81.

System Services

This section describes the actions you can perform on the system services.

1

On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Click the Appliance System Configuration icon.

=

3 Click System Services.

4 You can perform the following actions:

Section 8.6.1, “Starting, Stopping, or Restarting System Services,” on page 63
Section 8.6.2, “Setting System Services to Automatic or Manual,” on page 63

Section 8.6.3, “Downloading Log Files for System Services,” on page 64

Starting, Stopping, or Restarting System Services

1
2
3

Select the service that you want to start, stop, or restart.
Click Action, then click Start, Stop, or Restart.

Click Close to exit System Services.

Setting System Services to Automatic or Manual

1
2

Select the service that you want to make automatic or manual.

Click Action, then click Set as Automatic, or Set as Manual.
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8.6.3 Downloading Log Files for System Services

The Log Files section is not available on iPrint Appliance 1.0.1. However, you can view the log files
on the server at the following locations.

Novell iPrint Mobile and iManager: /var/opt/novell/tomcat6/logs/catalina.out
Novell iPrint Mobile log: /var/opt/novell/log/iprintmobile/iprintmobile0.log
Management Console: /var/opt/novell/jetty8/logs/jetty.stderrout.out

Export Backup Log: /var/opt/novell/log/iprintmobile/backup.log

Upgrade Restore log: /var/opt/novell/log/iprintmobile/restore.log

Print Manager: /var/opt/novell/log/iprint/ipsmd.log

Driver Store: /var/opt/novell/log/iprint/idsd.log

eDirectory: /var/opt/novell/eDirectory/log/ndsd.log

Apache: /var/log/apache2/error_log

Avahi: /var/log/messages

8.7 Firewall

You can view your current firewall configuration directly from the iPrint Appliance:

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the Appliance System Configuration icon.

z

3 Click Firewall.

Port numbers are listed with the current status of each port number. This page is for
informational purposes and is not editable.

For more information about port numbers in iPrint Appliance, see Chapter 11, “iPrint Appliance
Firewall Exceptions,” on page 79.

8.8 Shutting Down and Restarting iPrint Appliance

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the Appliance System Configuration icon.
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3 Click Reboot or Shutdown.

8.9 Signing Out of iPrint Appliance

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Specify the Username and Password, then click Log in.

3 In the upper-right corner of the page, next to the user name, click Logout.

NOTE: On the Appliance System Configuration and iPrint Appliance Configuration pages of iPrint
Appliance, you can see the user name displayed along with the Home and Logout links. The Home
link directs you to the iPrint Appliance main page, and the Logout link allows you to sign out of
iPrint Appliance.
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9.1

9.11

IPrint Appliance Management

The Novell iPrint Appliance Management Console allows you to add and manage printers, check the
printer status, create printer maps, and monitor iPrint Appliance.

To access the Management Console, on a Web browser, specify either the DNS name or the IP
address. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

The iPrint Appliance Management Console page displays the following options:

¢ Section 9.1, “iPrint Appliance Configuration,” on page 67

¢ Section 9.2, “iPrint Printer Configuration (iManager),” on page 74
¢ Section 9.3, “iPrint Printer Status,” on page 74

¢ Section 9.4, “iPrint Printer Import / Migration,” on page 74

¢ Section 9.5, “iPrint Map Creation,” on page 74

¢ Section 9.6, “Ganglia,” on page 75

IPrint Appliance Configuration

The iPrint Appliance Configuration page displays the following options:

¢ Section 9.1.1, “Mobile Configuration,” on page 67
¢ Section 9.1.2, “Printers,” on page 69

¢ Section 9.1.3, “Renderers,” on page 70

¢ Section 9.1.4, “Services,” on page 70

¢ Section 9.1.5, “Export Configuration,” on page 70
¢ Section 9.1.6, “LDAP Import,” on page 70

¢ Section 9.1.7, “License,” on page 74

Mobile Configuration

On the Mobile configuration page, you can configure Email printing, Printer Defaults, and Renderer
Options.

Email Configuration

iPrint Appliance can be configured to accept print jobs through email messages and attachments.
When configured for email printing, iPrint Appliance becomes a client to an email server. Email
account inbox(es) are polled for incoming print jobs, which are routed to the intended printer. Email
accounts must be created and functional prior to their association with Novell iPrint Appliance.
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Enable email-based printing: Select this option to enable email printing. A global email address can
be assigned for all printers. The global email address feature requires access to an email account such
as GroupWise, Exchange, Lotus Notes, or Gmail.

The following fields are used by iPrint Appliance to describe and access the global email account:

Email address: Specify the full email address for global print jobs. iPrint Appliance polls the inbox of
this email address looking for print jobs. When an email-based job arrives, the subject line is parsed
to determine the printer to which the job is sent. For example, print@example.com.

Account Username: Specify the user name for iPrint Appliance to log in to the email server to access
the global email account. For example, iprint.

Account Password: Specify the password for iPrint Appliance to log in to the email server to access
the global email account.

Re-type Password: Confirm the account password.

Incoming Mail Server: Specify the address of the incoming mail server for the email account. For
example, imap.example.com.

Incoming Server Type: iPrint Appliance supports POP and IMAP protocols to poll for incoming
print jobs. Select POP or IMAP depending on the protocol that your email server supports.

Outgoing (SMTP) Mail Server: Specify the address of the outgoing mail server for the email
account. For example, smtp.example.com. iPrint Appliance uses the SMTP protocol to send email
back to users who submit email-based print jobs to report their job status. In order to support iPrint
Appliance, the email server you select must support the SMTP protocol.

Enable Mail-body Printing: With email-based printing, attachments are always printed. This option
allows the email message body to also be printed. It is enabled by default.

NOTE: Each instance of iPrint Mobile service must be configured with a unique email address,
which cannot be shared with other instances of mobile service. Similarly, an email address used for a
particular printer (per printer email configuration) cannot be shared for any other printer or mobile
service.

Printer Defaults

Printer features managed by iPrint Appliance can be enabled and disabled. The fields in this section
are the default values for newly added printers. As each printer is added, these values can be
modified.

Paper Size: Select Letter or A4.
Orientation: Select between Landscape or Portrait printing orientation.

Enable Duplex Printing: Duplex printing allows automatic printing of a sheet of paper on both
sides. Print devices without this capability can only print on a single side of paper (simplex printing).

Enable Color Printing: Color (or Colour) printing prints the documents in color, as opposed to
monochrome (black and white) printing.

Novell iPrint Appliance 1.0.1 Administration Guide



9.1.2

Renderer Options

Print jobs arrive from iPrint clients in a variety of file formats. By default, these files are rendered to a
format that can be printed (by the target printer) using LibreOffice. However, there are several file
formats that are not perfectly rendered by LibreOffice. To provide a more precise rendering, one or
more external “Novell iPrint Windows Renderers” must be installed and configured on a Windows 7
64-bit machine.

External renderers connect to iPrint Appliance and poll the un-rendered print jobs queue for files that
the external renderer can more expertly render. The rendered jobs are then returned to iPrint
Appliance for printing.

For the external renderer to connect to iPrint Appliance, an Authentication Key is required. If the
external renderer's Authentication Key matches the Authentication Key specified in this field, the
external renderer is granted access to poll the un-rendered print jobs.

The Authentication Key can be a combination of a string of characters. The key is used to authorize
an external document renderer with iPrint Appliance.

Printers

The Printers page lists all printers currently managed by iPrint Appliance (created using iManager).
You can enable a printer for AirPrint, Email printing, and IPP printing. Select a printer, click the
AirPrint or Mobile drop-down menu, then click Enable.

You can also assign a specific email address to each printer by clicking the Configure drop-down
menu, then clicking Private Email Settings. When configured for private email printing, iPrint
Appliance becomes a client to an email server. You must provide the following information to enable
a private email address for the printer:

Account + Email Address: Specify the full email address of the mailbox to be polled for the
print jobs. When an email-based job arrives, the print job is processed to the
printer. For example, print@example.com.

* Username: Specify the user name to be used by iPrint Appliance to log in to the
email server to access the private printer email account. For example, iprint.

+ Password: Specify the password for iPrint Appliance to log in to the email
server to access the private printer email account.

+ Retype Password: Confirm the account password.
Server + Incoming Mail Server: Specify the address of the incoming email server for the
email account. For example, imap.example.com.

+ Outgoing Mail Server: Specify the address of the outgoing email server for the
email account. For example, smtp.example.com.

+ Access Method: iPrint Appliance supports two different protocols to poll for
incoming print jobs. Select POP or IMAP depending on the protocol your email
server supports.

NOTE: An email address used for a particular printer (per-printer email configuration) cannot be
shared for any other printer or mobile service.

IMPORTANT: If you configure a printer for private email printing and then disable the printer for
Mobile printing, the private email configuration settings are deleted. If you want to enable private
email printing in future, you must specify the information manually.
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9.1.3

9.14

9.15

9.1.6

Renderers

The Renderers page allows you to download iPrint Windows Renderer. The page also displays all
document renderers registered with iPrint Appliance.

Services

The Services page displays the system services that are required for iPrint Appliance. To enable or
disable a service, select a service on the page, click the Action drop-down menu, then click Start, Stop,
or Restart.

You can set the Startup Type of the services to Automatic or Manual by clicking the Options drop-
down menu, then clicking Set as Automatic or Set as Manual.

To refresh the information on the page, click Refresh List.

Export Configuration

The Export Configuration page allows you to create a backup of the iPrint Appliance configuration.
The configuration information is exported to the iprintconfig.zip file. This file can be used when
upgrading iPrint Appliance or installing a new copy.

NOTE: Log files are not backed up when exporting the configuration file. If you want to back up files
and folders that are not backed up by default, you must add the path of those files manually into the
additionalBackupList file located at /etc/opt/novel l/iprintmobile/conf/
additionalBackupList/.

On iPrint Appliance 1.0, the permissions for files/directories added to the additionalBackupList
file are not retained during backup. You must add the permissions manually.

To export the configuration, provide the eDirectory administrator Password, then click Export. When
upgrading to a new iPrint Appliance, you must use the eDirectory administrator password. The
eDirectory administrator is usually the admin user cn=admin,o=iPrintappliance.

Any configuration change in iPrint Appliance takes at least 20 minutes to get updated to the
configuration file. If you export the iPrint Appliance configuration file within 20 minutes of
modifying the configuration settings, and then import the configuration file into another copy of
iPrint Appliance, the changes are not captured. In this case, you might not be able to view the
updated information in the iPrint Appliance. We recommend that you wait at least 20 minutes after
the last configuration change before you export the configuration file.

For information on upgrading iPrint Appliance, see Section 4.1.2, “Upgrade,” on page 27.

LDAP Import

To create an iPrint Appliance user account, you can synchronize initial user information from your
network directory service (NetlQ eDirectory or Microsoft Active Directory service) after you have
installed the iPrint Appliance software. Over time, you can continue to synchronize user information
from the LDAP directory to your iPrint Appliance.

When you synchronize user information into iPrint Appliance from a source LDAP directory service,
the entire Base DN on the source is imported into iPrint Appliance. For example, if you sync the
context o=users from an LDAP source, the same o=users context is created in iPrint Appliance.

Novell iPrint Appliance 1.0.1 Administration Guide



IMPORTANT:

¢ iPrint Appliance performs one-way synchronization from the LDAP directory. If you change
user information in iPrint Appliance, the changes are not synchronized back to your LDAP
directory. It is recommended that you do not change synced LDAP user information on iPrint
Appliance.

¢ iPrint Appliance does not support multi-value attributes. If your LDAP directory contains multi-
value attributes, iPrint Appliance recognizes only the first attribute. For example, if your LDAP
directory contains multiple email addresses for a given user, only the first email address is
synchronized to iPrint Appliance.

¢ LDAP import does not sync user passwords to iPrint Appliance. Authentication requests from
the mobile app are redirected to the defined LDAP source. If a user password is changed on the
LDAP source, you do not need to update the same password on iPrint Appliance.

¢ The LDAP source IP or DNS name must be always active for iPrint Appliance to authenticate
users.

You can configure multiple LDAP connections. To create a new LDAP connection, click Add a New
LDAP Source on the LDAP Import page.

For information on importing certificates into iPrint Appliance when using LDAP, see the knowledge
base article: How to enable SSL to Teaming LDAP Synchronization and Authentication.

Each connection requires the following configuration information:

¢ “LDAP Server URL” on page 71

¢ “User DN (Proxy User for Synchronizing Users and Groups)” on page 72
+ “LDAP Attribute to Identify a User or Group” on page 72

¢ “LDAP Attribute for iPrint Appliance User Name” on page 72

¢ “User and Group Object Locations” on page 73

¢ “LDAP Synchronization” on page 74

LDAP Server URL

In order to synchronize initial user information, iPrint Appliance must access an LDAP server where
your directory service is running. You must provide the hostname of the server, using a URL with the
following format:

Idap://hostname

If the LDAP server requires a secure SSL connection, use the following format:

Idaps://hostname

If the LDAP server is configured with a default port number (389 for non-secure connections or 636
for secure SSL connections), the port number is not required in the URL. If the LDAP server uses a
different port number, use the following format for the LDAP URL:

Idap://hostname :port_number
Idaps://hostname:port_number

If the LDAP server requires a secure SSL connection, additional setup is required. You must import
the root certificate for your LDAP directory into the Java KeyStore (JVM Certificates) from
Management Tools > Appliance System Configuration > Digital Certificates on the iPrint server, before you
configure iPrint Appliance for LDAP synchronization.
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User DN (Proxy User for Synchronizing Users and Groups)

To sync users into iPrint Appliance, you must provide the user name and password of a user who has
sufficient rights to access the user information on the LDAP server.

In your LDAP directory tree, you must provide the fully qualified, comma-delimited user name,
along with its context, in the format expected by your directory service.

Directory Service Format for the User Name
eDirectory cn=username,ou=organizational_unit,o=0organization
Active Directory cn=username,cn=organizational_unit,dc=domain_component or

cn=username,ou=organizational_unit,dc=domain_component

LDAP Attribute to Identify a User or Group

The LDAP attribute that uniquely identifies a user or group helps facilitate renaming and moving
iPrint users and groups in the LDAP directory. If this attribute is not set and you rename or move a
user in the LDAP source directory, iPrint Appliance assumes that the new name (or the new location
of the same name) represents a new user rather than a modified user, and creates a new iPrint
Appliance user.

For example, you have an iPrint user with a given name of William Jones. If William changes his
name to Bill and you make that change in the LDAP directory, iPrint Appliance creates a new user
named Bill Jones.

To ensure that iPrint Appliance modifies the existing user instead of creating a new user when the
user is renamed or moved in the LDAP directory, you must specify the name of the LDAP attribute
that uniquely identifies the user. For eDirectory, this value is GUID. For Active Directory, this value is
objectGUID. This attribute always has a unique value that does not change when you rename or
move a user in the LDAP directory. If you want to map users to a different attribute, you must ensure
that the attribute that you use is a binary attribute. For example, the cn attribute cannot be used
because it is not a binary attribute.

LDAP Attribute for iPrint Appliance User Name

The setting LDAP Attribute Used for iPrint Appliance User Name is used for two purposes:

¢ The value is used as the iPrint Appliance user name when the user is first provisioned from
LDAP. The value of this attribute must be unique.

¢ During iPrint Appliance login, iPrint Appliance uses this attribute to locate the user in the LDAP
directory, and then tries to authenticate as that user.

LDAP directories differ in the LDAP attribute used to identify a User object. Both eDirectory and
Active Directory might use the cn (common name) attribute. A more sure alternative for Active
Directory is to use the sAMAccountName attribute. Other LDAP directories might use the uid (unique
ID) attribute, depending on the structure and configuration of the directory tree.

Consult with your directory administrator in order to determine the best attribute to use. In some
cases where not all users are being imported successfully, you must set up two LDAP sources
pointing to the same LDAP server and have each source use a different value for the LDAP Attribute
Used for iPrint Name. For example, set up one LDAP source and use cn as the LDAP Attribute Used for
iPrint Name, and then set up a separate source to the same LDAP server and use sAMAccountName as
the LDAP Attribute Used for iPrint Name.

Novell iPrint Appliance 1.0.1 Administration Guide



In addition to the attributes already mentioned in this section, other LDAP attributes can be used for
the LDAP Attribute Used for iPrint Name, as long as the attribute is unique for each User object. For
example, the mai | LDAP attribute on User objects can be used to enable iPrint Appliance users to log
in by using their email addresses.

User and Group Object Locations

iPrint Appliance can find and synchronize initial user information from User objects located in one or
more containers in the LDAP directory tree. A container under which User objects are located is
called a base DN (distinguished name). The format you use to specify a base DN depends on your
directory service.

Directory Service Format for the User Container

eDirectory ou=organizational_unit,o=organization

Active Directory ou=organizational_unit,dc=domain_component
or

cn=organizational_unit,dc=domain_component

To identify potential iPrint users, iPrint Appliance by default filters on the following LDAP directory
object attributes:

¢ Person
¢ orgPerson

¢ inetOrgPerson

If you want to create iPrint groups based on information in your LDAP directory, iPrint Appliance
filters on the following LDAP directory object attributes:

+ group

¢ groupOfNames

¢ groupOfUniqueNames

You can add attributes to the user or group filter list if necessary. You can use the following operators
in the filter:

¢ | OR (the default)

¢+ & AND

+ INOT

You can choose whether you want iPrint Appliance to search for users (and optionally, groups) in
containers below the base DN (that is, in subtrees).

You can create a group that consists of all the users that you want to set up in iPrint Appliance,
regardless of where they are located in your LDAP directory. After you create the group, you can use
the following filter to search for User objects that have the specified group membership attribute:

(groupMembership=cn=group_name,ou=organizational_unit,o=organization)

IMPORTANT: Ensure that you include parentheses in your filter.
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9.2

9.3

9.4

9.5

LDAP Synchronization

Synchronization options apply to all LDAP configurations.

You can perform LDAP synchronization every day, or on specific days of the week. You can also
perform a sync once a day at a specified time, or multiple times each day. The smallest time interval
you can set is .25 hours (every 15 minutes).

To synchronize users and groups immediately, select Run Immediately.

NOTE: If you want to delete users that are synced from a particular LDAP source, you must delete
the LDAP source connection then run an LDAP sync. When you delete an LDAP source, the users
and groups from that context are deleted while the context itself is retained.

License

For information on iPrint Appliance Licensing, see Chapter 10, “iPrint Appliance License
Information,” on page 77.

iPrint Printer Configuration (iManager)

iManager is a tool that allows you to manage your print environment. You can create printers, printer
drivers, profiles, and users. You can also manage workstations.

For more information about managing your print system using iManager, see the Managing Your
Print System section in the OES 11 iPrint Administration Guide.

IPrint Printer Status

The iPrint Printer Status tools provides a global view of your print system. The tool displays the
current status of Printer Agents, and lets you configure settings and generate reports about your
print system.

For more information about the iPrint Printer Status tool, see the iPrint Manager Health Monitor
Administration Guide.

IPrint Printer Import / Migration

The iPrint Printer Import link provides information on how to migrate printers from an existing OES
iPrint system or iPrint Appliance.

IPrint Map Creation

You can use the iPrint Map Designer to create a map displaying the location of printers. Users can
identify and install the printers that are nearest to their location.

For more information about creating a map, see Setting Up Location-Based Printing in the iPrint
Linux Administration Guide.
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9.6

Ganglia

Ganglia is a scalable, distributed monitoring system that allows you to gather important metric data
about the performance of your iPrint Appliance. The default metrics that you can monitor are
processor, disk, load, memory, network, and process.

For information about how to configure Ganglia for your environment, including changing from
multicast mode to unicast mode, see Section 8.5, “Ganglia Configuration,” on page 62.
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IPrint Appliance License Information

On the License page of iPrint Appliance, you can view information about your current iPrint
Appliance license.
¢ Section 10.1, “Accessing the License Page,” on page 77

¢ Section 10.2, “Updating the iPrint Appliance License,” on page 77

10.1 Accessing the License Page

You can access the License page of iPrint Appliance by using the Management Console.
1 On a Web browser, specify either the DNS name or the IP address of iPrint Appliance. For
example, https://10.0.0.1:9443 or http://iprint.example.com/admin.
2 Log in using admin or root credentials.
3 Click the iPrint Appliance Configuration icon.
4 Under Administration, click License.

iPrint ships with a 60-day evaluation license. You must update this license to a full product
license.

On the License page, the Current License Information section displays information about your
current iPrint license, including the date it was issued and the number of days from the issue
date that the license is valid.

10.2 Updating the iPrint Appliance License

To update your iPrint Appliance license:
1 On the system where you have installed iPrint Appliance, navigate to Zopt/novell/filr/
apache-tomcat/webapps/ssf/WEB-INF/license.

2 Download the iPrint Appliance license file, then copy it to the directory Zopt/novell/filr/
apache-tomcat/webapps/ssf/WEB-INF/license.

IMPORTANT: If you are running multiple copies of iPrint Appliance, you must update the
license for each copy of iPrint Appliance individually.
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IPrint Appliance Firewall Exceptions

If you have a firewall, you must allow the port numbers listed below to ensure that you have a
seamless experience with iPrint Appliance.
¢ Section 11.1, “Inbound Connections to iPrint Appliance,” on page 79

¢ Section 11.2, “Outbound Connections from iPrint Appliance,” on page 79

11.1 Inbound Connections to iPrint Appliance

To allow printing access to your end users from a public network, you must allow the following
ports:

+ 80-HTTP

* 443 - HTTPS

+ 631 -IPP

To allow iPrint Appliance access to your administrators, you must allow the following ports:

¢ 80-HTTP

¢ 443 - HTTPS

* 636 - LDAPS

+ 389-LDAP

¢ 524 -NCP

* 631 -IPP

¢ 9443 - Management Console
¢ 515-LPR

¢ 22-SSH

¢ 5353 - mDNS/UDP (AirPrint)
+ 8080, 8081, 8443, 8444, and 8649 (Ganglia Configuration)

11.2 Outbound Connections from iPrint Appliance

iPrint Appliance uses the following ports to access external applications:

¢ 636 and 389 - For LDAP Import and user authentication to the configured LDAP sources
+ 80, 524, 443, 631, 636, and 389 - To access the source server for printer migration
¢ 5353 - To access the wireless network to advertise AirPrint printers

¢ 161, 515, and 9100 - To access printers
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Monitoring iPrint Appliance
Performance with Ganglia

Ganglia is a scalable, distributed monitoring system that allows you to gather important metric data
about the performance of your iPrint Appliance. The default metrics that you can monitor are
processor, disk, load, memory, network, and process.

Ganglia is not enabled by default. To monitor iPrint Appliance using Ganglia, you must enable
Ganglia Configuration in the Appliance System Configuration page of the iPrint Appliance
Management Console. For information in how to enable Ganglia Configuration, see Section 8.5,
“Ganglia Configuration,” on page 62.

To view Ganglia monitoring of your iPrint Appliance system:
1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.
2 Click the Ganglia icon.

An overview of all the nodes in the cluster, including information such as processor utilization,
memory, load, and so forth is displayed.

3 In the Grid-Node drop-down list, select a node that you want to monitor.
or
Scroll to the bottom of the page and click a node to get server information for your iPrint

Appliance.

For information about how to configure Ganglia for your environment, including changing from
multicast mode to unicast mode, see Section 8.5, “Ganglia Configuration,” on page 62.
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Advanced Configuration for iPrint
Mobile Service (Optional)

In addition to the Management Console, there are a few additional parameters that can be configured
to fine-tune the iPrint Mobile service, based on your network and printing requirements. The iPrint
Appliance Server Configuration file, located at /etc/opt/novell/iprintmobile/conf/
iprintmobile.conf, allows you to customize the iPrint Mobile service per your requirements.

You must configure the iprintmobi le.conf file manually. When assigning a value to any parameter,
ensure that you uncomment the line, in order for the changes to take effect. After configuring the file,
you must restart the iPrint Mobile service through the Management Console.

The iPrint Appliance Server Configuration file contains the following information:

NOTE: The advanced configuration is optional. For most environments, the configuration does not
require modifications.

Table 13-1 iPrint Appliance Server Configuration File Contents

Parameter Default Value Function

office_port 8100 Office background instance listens to this
port number.

home_directory Ivar/opt/novell/ A directory on the file system that is used to
iprintmobile store the data. This folder contains the
service metadata and temporary job data.

conversion_wait_time 60 Duration of time (in seconds) that the job
submission threads wait for the job
conversion threads.

db_backup_interval 10000 Duration (in milliseconds) after which the
database is backed up on the disk.

is_test_setup false Set this flag if the server is being set up for
testing and no dedicated email address is
available. Print job requests are read-only
from the Cabinet folder.

job_submission_thread_timeout 60 Duration of time for which an excess idle
thread waits before terminating.
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Parameter Default Value Function

delete_completed_job_data true Deletes the converted email print job data
stored at /var/opt/novel 1/
iprintmobile/jobs/. Set the value to
false to retain the converted job data for
email print jobs.

The /var/opt/novell/iprintmobile/jobs/ folder

does not maintain the IPP job data. IPP job
data includes job data from the Novell iPrint
app and Airprint. The job data for apps and

AirPrint are stored in the PA spool directory
of the Print Manager.

WARNING: If you set the value to false, you
must ensure that you delete the print job data
regularly to free up disc space. If the disk
space gets full, then email print jobs are not
processed.

fallback to_local_converter false If the Windows renderer fails, you can run
the job through a local converter.

num_email_receiver_threads 0 Configure this parameter to the maximum
number of threads to be used for processing
multiple mailboxes. By default (when set to
0), the number of threads to email addresses
ratio is 1:5 (1 thread per 5 email addresses).

use_global_address_for_notifications false By default, notifications are sent from the
printer-specific email address. Change the
value to 'true’ if you want to send notifications
to users using the global email address.

renderer_time_out 30000 Duration (in milliseconds) after which a
registered renderer times out and moves to
an inactive state.

verify_certificates false Disable certificate validation.
renderingOnlyServiceEnabled true RenderOnly Configuration
backendRenderingPollinginterval 500 Backend Rendering Polling Interval (in

milliseconds)

email_polling_interval 30000 Configures the interval (in milliseconds) at
which emails are fetched from mail servers.

subject_optional_for_printer_specific_emails true Stops printing emails without the correct
iPrint email print command. By default this
value is 'true." Emails forwarded to the
printer-specific email address, with or without
a subject line, are printed.

email_reconnect_interval 30 If the email server is unavailable, iPrint
Appliance tries to reconnect to the email
server after the specified duration (in
seconds).

84 Novell iPrint Appliance 1.0.1 Administration Guide



14.1

14.2

Backup and Restore iPrint Appliance

You can back up the configuration file of iPrint Appliance to protect against system or hard drive
crashes. You can also use the backup to transfer the configuration to another iPrint Appliance, or to

quickly restore iPrint Appliance.

Backup iPrint Appliance

You can back up iPrint Appliance through the Management Console.
1 On a Web browser, use either the DNS name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console.

2 Specify vaadmin or root as the user name.
3 Specify the password.
The Management Console page is displayed.
4 Click iPrint Appliance Configuration.
5 Under Administration, click Export Configuration.
6 Specify the eDirectory administrator Password, then click Export.

The iprintconfig.zip file is created. This is the backup file. The backup file contains the
configuration information.

IMPORTANT: The license file on iPrint Appliance 1.0 is not automatically backed up. To

backup the license file, you must add the absolute path of the license file manually into the

additionalBackupList file located at Zetc/opt/novel 1I/iprintmobile/conf/

additionalBackupList/. For example, if your license file name is Iicense.xml, you must add

the path Zopt/novel 1/filr/apache-tomcat/webapps/ssf/WEB-INF/license/license.xml

to the additionalBackupList file.

On iPrint Appliance 1.0, the permissions for files/directories added to the

additionalBackupList file are not retained during backup. You must add the permissions

manually.

Restore iPrint Appliance

If you want to restore iPrint Appliance, you must reinstall iPrint Appliance, and then follow the
procedure below. To reinstall iPrint Appliance, see Chapter 3, “Installing iPrint Appliance,” on

page 17.

Backup and Restore iPrint Appliance
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IMPORTANT: When restoring iPrint Appliance, you must ensure that the newly deployed version
of iPrint Appliance has the same network configuration, passwords, and time zone as that of the
older version of iPrint Appliance from which you exported the iprintconfig.zip configuration file.

1

On a web browser, use either the DNS name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

NOTE: Ignore the security certificate warning, and continue to the iPrint Appliance
Management Console.

Specify vaadmin or root as the user name.

Specify the password.

The Management Console page is displayed.

Click iPrint Appliance Configuration.

The iPrint Initial Configuration Wizard window is displayed.
Select Upgrade, then click Next.

In the File option, click Choose File, then select the configuration file exported from a previous
copy of iPrint Appliance.

Specify the eDirectory Password that you provided when exporting the configuration file from the
previous copy of iPrint Appliance.

Click Finish.
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Upgrading iPrint Appliance

You can upgrade to the latest version of iPrint Appliance from an earlier version, and quickly retrieve

all your configuration settings. To upgrade iPrint Appliance, you must:

1. Export the configuration file from your existing version of iPrint Appliance.
2. Install the new version of iPrint Appliance.

3. Import the configuration file to the new version of iPrint Appliance.

IMPORTANT: When upgrading to a new version of iPrint Appliance from an older version, you
must ensure that the newly deployed version of iPrint Appliance has the same network

configuration, passwords, and time zone as that of the older version of iPrint Appliance from which

you exported the iprintconfig.zip configuration file.

¢ Section 15.1, “Export the Configuration File,” on page 87
¢ Section 15.2, “Install the New Version of iPrint Appliance,” on page 88
¢ Section 15.3, “Import the Configuration File,” on page 88

Export the Configuration File

1 On a Web browser, use either the DNS name or the I Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console.

2 Specify vaadmin or root as the user name.
3 Specify the password.
The Management Console page is displayed.
4 Click iPrint Appliance Configuration.
5 Under Administration, click Export Configuration.
6 Specify the eDirectory administrator Password, then click Export.

The iprintconfig.zip file is created. The iprintconfig.zip file contains the configuration
information.

IMPORTANT: The license file on iPrint Appliance 1.0 is not automatically backed up. To
backup the license file, you must add the absolute path of the license file manually into the
additionalBackupList file located at Zetc/opt/novel 1/iprintmobile/conf/
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15.3
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additionalBackupList/. For example, if your license file name is Iicense.xml, you must add
the path Zopt/novel 1/filr/apache-tomcat/webapps/ssf/WEB-INF/license/license.xml
to the additionalBackupList file.

On iPrint Appliance 1.0, the permissions for files/directories added to the
additionalBackupList file are not retained during backup. You must add the permissions
manually.

Install the New Version of iPrint Appliance

After exporting the configuration file, install the new version of iPrint Appliance. For information on
installing iPrint Appliance, see Chapter 3, “Installing iPrint Appliance,” on page 17.

1

8

Import the Configuration File

On a web browser, use either the DNS name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

NOTE: Ignore the security certificate warning, and continue to the iPrint Appliance
Management Console.

Specify vaadmin or root as the user name.

Specify the password.

The Management Console page is displayed.

Click iPrint Appliance Configuration.

The iPrint Initial Configuration Wizard window is displayed.
Select Upgrade, then click Next.

In the File option, click Choose File, then select the configuration file exported from a previous
copy of iPrint Appliance.

Specify the eDirectory Password that you provided when exporting the configuration file from the
previous copy of iPrint Appliance.

Click Finish.

The iPrint Appliance upgrade process is now complete.
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Troubleshooting iPrint Appliance

You might encounter the following issues when using iPrint Appliance.

NOTE: The iPrint Appliance print server maintains log files to help with debugging the server's
activity. The log files are located at the following locations:

*

*

*

Novell iPrint Mobile and iManager: /var/opt/novel 1/tomcat6/logs/catalina.out
Novell iPrint Mobile log: /var/opt/novel1/log/iprintmobile/iprintmobile0. log
Management Console: /var/opt/novell/jetty8/logs/jetty.stderrout.out
Export Backup Log: /var/opt/novell/log/iprintmobile/backup.log

Upgrade Restore log: /var/opt/novell/log/iprintmobile/restore.log

Print Manager: /var/opt/novell/log/iprint/ipsmd. log

Driver Store: /var/opt/novell/log/iprint/idsd.log

eDirectory: /var/opt/novell/eDirectory/log/ndsd. log

Apache: /var/log/apache2/error_log

Avahi: /var/log/messages

Section 16.1, “iPrint Mobile Service Fails to Connect,” on page 90

Section 16.2, “Unable to Import All Users from the Active Directory Source Using LDAP Sync,”
on page 91

Section 16.3, “iPrint Windows Rendering Service Hangs,” on page 91
Section 16.4, “iPrint Rendering Service Registration to the Appliance Server Fails,” on page 91

Section 16.5, “iPrint Renderer Status Is Inactive after Exporting or Upgrading iPrint Appliance,”
on page 92

Section 16.6, “Printer Prints Junk Characters,” on page 92

Section 16.7, “Secure Printer Continues Printing after Changing the User Password (Local
Appliance eDirectory Users Only),” on page 92

Section 16.8, “iPrint Windows Renderer Fails to Start Because of Login Failure,” on page 93
Section 16.9, “AirPrint Printers Are Listed Twice During Printer Discovery,” on page 93

Section 16.10, “AirPrint Printers Are Not Listed,” on page 94

Section 16.11, “Print Job Submitted Using AirPrint Shows Processing Continuously,” on page 94

Section 16.12, “Processor Utilization Increases When 10,000 Users Are Imported from an
External LDAP Source,” on page 94

Section 16.13, “iPrint Appliance Migration Target Server SSL Authentication Fails,” on page 95
Section 16.14, “RPC Error When Enabling Printers for Mobile Printing,” on page 95

Section 16.15, “iPrntRendCmd Stops Responding During Configuration or Other Command
Line Operations,” on page 95
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Section 16.16, “Apache Services Fails to Use the Certificate Key Store,” on page 96

Section 16.17, “Unable to Configure Email Printing When SSL Is Enabled for IMAP in
GroupWise,” on page 97

Section 16.18, “Upgrade Progress Bar Continues Processing,” on page 97

Section 16.19, “iPrint Rendering Service Fails to Start If the Windows User Account Password
Changes or Expires,” on page 98

Section 16.20, “DataStore Creation Fails,” on page 98

Section 16.21, “Garbage Characters Printed When Printing from Gmail on Internet Explorer,” on
page 98

Section 16.22, ““Canceled by Operator” Messages in the Audit Logs,” on page 98
Section 16.23, “Printers Not Listed in PSM after Upgrading iPrint Appliance,” on page 99
Section 16.24, “Unable to Create CUPS Printer Name with a Space Character,” on page 99

Section 16.25, “Upgrading iPrint Appliance 1.0 Does Not Automatically Export the License File,”
on page 99

Section 16.26, “Unable to Remove Inactive Renderer Entries from the Management Console,” on
page 100

Section 16.27, “Upgrade Option Missing for iPrint Windows Renderer,” on page 100

Section 16.28, “LDAP Import Fails to Import Administrator User from Active Directory
Environments,” on page 100

Section 16.29, “Disk Space Gets Filled Up During Continuous Job Submission,” on page 101
Section 16.30, “Adobe Acrobat 11 Pro Hangs While Rendering PDF Files,” on page 101
Section 16.31, “Unable to Backup iPrint Appliance 1.0,” on page 101

Section 16.32, “Port 515 (LPR) Disabled in the Firewall on iPrint Appliance,” on page 102

IPrint Mobile Service Fails to Connect

The iPrint Mobile service might fail to connect if the Apache server has connectivity issues with
Tomcat, which is hosting the iPrint Mobile service.

To resolve this issue, restart the Apache service from the iPrint Appliance Management Console:

1 On a Web browser, use either the DNS name or the IP address to access the Management

Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the iPrint Appliance Configuration icon.

3 Click Services.

4 Select Apache server for Novell for iPrint.

5 Click the Action drop-down menu, then click Restart.
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16.2 Unableto Import All Users from the Active Directory Source
Using LDAP Sync

You might not be able to import all users from the Active Directory source using LDAP sync. By
default, in Active Directory, LDAP search returns only 1,000 objects. This issue is caused by a default
setting in Active Directory that limits LDAP searches to 1,000 results.

To work around this issue, you can use the Ntdsuti I .exe tool to modify the MaxPageSize value to
expand or limit the search, depending on the size of the Active Directory tree.

For more information, see the Microsoft support article on How to view and set LDAP policy in
Active Directory by using Ntdsutil.exe.

16.3 iPrint Windows Rendering Service Hangs

The iPrint Windows Rendering Service might hang with the service status “Stopping.”

This issue is caused when iPrint Windows Renderer fails to restart when using the configuration or
registration commands.

To workaround this issue:

1 Launch the Windows Task Manager.

2 Click the Processes tab.

3 Check the Show processes from all users box.

4 Right-click iPrint Rendering Service.exe, then click End Process.

5 Start the iPrint Windows Renderer service by using the iprntrendcmd -1 command or through
the window services panel.

16.4 iPrint Rendering Service Registration to the Appliance
Server Fails

The iPrint Rendering Service registration to the Appliance server might fail if the Apache server has
connectivity issues.

To resolve this issue, restart the Apache service from the iPrint Appliance Management Console:
1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.
2 Click the iPrint Appliance Configuration icon.
3 Under Administration, click Services.
4 Select Apache server for Novell for iPrint.
The Action and Options drop-down menus are activated.

5 Click the Action drop-down menu, then click Restart.
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16.5 iPrint Renderer Status Is Inactive after Exporting or
Upgrading iPrint Appliance
When you upgrade or export iPrint Appliance, the iPrint Windows Renderer status might be
“Inactive.” To work around this issue, you must unregister and re-register iPrint Windows Renderer.

To unregister iPrint Windows renderer:

1 Launch the command prompt in the Run as administrator mode.

2 Run the command iPrntRendCmd.exe -u <iPrintAppliance DNS name or IP address>
<authentication key>.

To register iPrint Windows Renderer:

1 Launch the command prompt in the Run as administrator mode.

2 Run the command iPrntRendCmd.exe -r <iPrintAppliance DNS name or IP address>
<authentication key>.

16.6 Printer Prints Junk Characters

When trying to print a document, the printer might print only junk characters and not the actual
content. This can be caused by an incompatible printer driver.

To work around this issue, use the drivers that are compatible with your printer. For information on
adding the correct printer drivers, see Appendix D, “Printing Using Specific Printer Drivers,” on
page 111.

16.7 Secure Printer Continues Printing after Changing the User
Password (Local Appliance eDirectory Users Only)

When users change their passwords, secure printers might continue printing with the old password
for up to 10 minutes. This is because of caching inside the iPrint LDAP authentication module, and
affects only the users created inside the local eDirectory tree on iPrint Appliance.

To fix this issue, add the parameters LDAPDNCacheTTL and LDAPDNCacheEntries to the
iprint_g.conf file, located at Zetc/opt/novel I/iprint/httpd/conf/iprint_g.conf as shown
below:

To change the caching time to 30 seconds:

<IFModule mod_authnz_ldapdn.c>
LDAPDNCacheTTL 30

</1fModule>

To disable caching;:

<IFModule mod_authnz_ldapdn.c>

LDAPDNCacheEntries -1
</1ftModule>
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After updating the iprint_g.conf file, launch the terminal window, and then restart the Apache
service using the iPrint Appliance Management Console:

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the iPrint Appliance Configuration icon.

3 Under Administration, click Services.

4 Select Apache server for Novell for iPrint.
The Action and Options drop-down menus are activated.

5 Click the Action drop-down menu, then click Restart.

16.8 iPrilnt Windows Renderer Fails to Start Because of Login
Failure

The iPrint Windows Renderer service might not start if the credentials provided are incorrect, or if
the user account does not have the Log on as a service rights.

To resolve this issue, you must assign the Log on as a service rights to the user account with which you
want to set up the renderer, on the local machine:

1 Go to Start > Control Panel > Administrative Tools > Local Security Policy.

2 In the left pane, double-click Local Policies.

3 Click User Rights Assignment.

4 In the right pane, under Policy, double-click Log on as a service.

5 Click Add User or Group.

6 Add the user account to the list, then click OK.

7 Click OK, then close the Local Security Policy window.

16.9  AirPrint Printers Are Listed Twice During Printer Discovery

iPrint AirPrint uses the same advertising medium (mDNS) as that of Apple’s AirPrint. Therefore, an
AirPrint printer is listed twice during printer discovery.

To resolve this issue, disable the advertisement from iPrint Appliance.
1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.
2 Click the iPrint Appliance Configuration icon.
3 Under Administration, click Printers.

4 Select the printer for which you want to disable advertising. You can select multiple printers by
holding the Ctrl key on your keyboard, then selecting the printers.

5 Click the AirPrint drop-down menu, then select Disable Advertising.
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16.10

16.11

16.12

AirPrint Printers Are Not Listed

When trying to print, you might not be able to see any AirPrint printers listed.

To resolve this issue, try disabling and re-enabling the wireless connection on the iOS device. If you
are still unable to view the printers, restart the Avahi service on the AirPrint server through the iPrint
Appliance Management Console:

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the iPrint Appliance Configuration icon.

3 Under Administration, click Services.

4 Select Avahi.
The Action and Options drop-down menus are activated.

5 Click the Action drop-down menu, then click Restart.

Print Job Submitted Using AirPrint Shows Processing
Continuously

On iOS devices, when you submit a print job, the Print Center continuously shows that the job is
processing. This issue occurs when a printer to which you are trying to print is redirected or not
working.

To resolve this issue on a redirected printer, disable advertising on a redirected printer so that the
printer is not displayed as an AirPrint printer. Advertise the target printer instead.

To resolve this issue on a printer that is not working, disable advertising and fix the printer before
enabling advertising on the printer.

1 On a web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the iPrint Appliance Configuration icon.

3 Under Administration, click Printers.

4 Select the printer for which you want to disable advertising. You can select multiple printers by
holding the Ctrl key on your keyboard, then selecting the printers.

5 Click the AirPrint drop-down menu, then select Disable Advertising.
6 Fix the printer.
7 Click the AirPrint drop-down menu, then select Enable Advertising.

Processor Utilization Increases When 10,000 Users Are
Imported from an External LDAP Source

When syncing users from an external LDAP source, the processor utilization increases if you try to
import 10,000 users.

The reason for this behavior is that the User Sync is scheduled to run every 8 minutes, by default.
Therefore, each time the User Sync is started, which is every 8 minutes, the processor utilization
increases to around 50%, and remains in that state for up to 5 minutes. The utilization might further
increase if you import over 10,000 users.

94 Novell iPrint Appliance 1.0.1 Administration Guide



16.13

16.14

16.15

To workaround this issue, you can change the sync interval by editing the crontab file.

1 Launch the crontab file located at /etc/crontab.
2 Browse to the line where the sync interval is set to 8 minutes.
# run iprint migrate every 8 minutes

*/8 * * * * root /usr/bin/python /Zopt/novell/iprintmobile/python/migrate/
migrateUsers.pyc >> /var/log/ipmigrate.log 2>&1

3 Change the time to the desired time interval.

For information on scheduling time intervals for cron jobs, see the article about Cron on Wikipedia.

IPrint Appliance Migration Target Server SSL
Authentication Fails

iPrint Appliance Migration target server SSL authentication might periodically fail.

To work around this issue, close the miggui application and launch it again.

RPC Error When Enabling Printers for Mobile Printing

When enabling printers for Mobile printing using the iPrint Appliance Management Console, you
might encounter an RPC error.

To work around this issue, you can log out and log in to the iPrint Appliance Management Console if
the browser session is open for a long time, or you can refresh the Printers page. If you are still seeing
the RPC error, restart the Print Manager service, and then try to enable the printer for mobile
printing.

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

2 Click the iPrint Appliance Configuration icon.

3 Under Administration, click Services.

4 Select Print Manager.
The Action and Options drop-down menus are activated.

5 Click the Action drop-down menu, then click Restart.

IPrntRendCmd Stops Responding During Configuration or
Other Command Line Operations

When configuring or modifying iPrint Windows Renderer, the iprntrendcmd command might stop
responding.

To work around this issue, close the command prompt that is currently open, launch a new
command prompt window, and then try the iprntrendcmd command again.
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16.16

96

Apache Services Fails to Use the Certificate Key Store

When you import CA-signed or third-party certificates into iPrint Appliance using the Management
Console, the Apache service continues to use the old certificates.

To work around this issue, you must manually replace the certificates. Ensure that the certificate you
want to replace is in the .crt format, and that you have the _key file. If you have the certificate in a
different format, (for example, .pfx, .p12, or .pem), you must extract, or convert them to .crt and
-key formats. You might also have a third file (intermediate CA certificate) also in .crt format.

NOTE: If you have a .pfx file you must first extract the .crt and .key files. To learn how to extract
these files, see Section 16.16.1, “Extracting Certificates and Key From PFX File,” on page 97. After you
have extracted the files, follow the procedure below.

1 Login to iPrint Appliance using SSH.

2 Navigate to the /vastorage/conf/certs/ directory.

3 Backup the existing certificate files to a backup directory by using the mv command.

0o N o O

10
11

12

13

Ensure that you move all the files. The files include vaserver.*, keystore, and keystoredb.
Keystoredb may not always exist.

Copy all certificates, and the key file (.crt and .key) to the /vastorage/conf/certs/ directory
by using the command scp, or the winscp application.

If you have extracted the files from a .pfx file, and have the .crt and .key files stored in the
appliance, copy the files using the cp command.

Rename the .crt file to vaserver .crt.
Rename the .key file to vaserver .key.
Rename the intermediate CA certificate file to CACert.crt.

Convert the certificates and the key file to .pfx format so that it can be imported to the Java
keystore.

8a Run the command openssl pkcsl2 -export -out vaserver.pfx -inkey
vaserver.key -in vaserver.crt -certfile CACert.crt.

8b When prompted for a pass phrase for vaserver .key, specify the pass phrase that you used
while generating the key.

8c When prompted for the export password, specify changeit.
8d Verify the export password by specifying changeit.
Import the . pfx file to keystore.

9a Run the command keytool -importkeystore -srckeystore vaserver._pfx -
srcstoretype pkcsl2 -destkeystore keystore.

9b For all the prompts that follow, specify changeit.
In the file /etc/apache2/vhosts.d/vhost-ssl .conf, search for SSLCertificateChainFile.

Uncomment the line #SSLCertificateChainFile /etc/apache2/ssl.crt/ca.crt. by
removing the #.

Modify the path to the location of the CACert.crtfile. For example, SSLCertificateChainFile
/vastorage/conf/certs/CACert.crt.

Save and close the vhost-ssl .conf file.
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16.18

14 Edit the /etc/ssl/servercerts/passphrase.sh file, then add the key pass phrase.
14a Replace the string changeit, with the pass phrase that you used while generating the key.
15 Restart apache using the command rcapache2 restart.

16 Restart jetty using the command rcnovell-jetty restart.

Extracting Certificates and Key From PFX File

1 Copy the .pfx file to any location on iPrint Appliance by using the command scp, or the winscp
application.

2 Extract the certificate file from the . pfx file by using the command openssl pkcsl2 -in
<file_path.pfx> -clcerts -nokeys -out vaserver.crt.

3 Extract the key file from the .pfx file by using the command openssl pkcsl2 -in
<file_path.pfx> -nocerts -nodes -out vaserver.key.

4 Extract the CA certificate from the .pfx file by using the command openssl pkcsl2 -in
<file_path.pfx> -nodes -nokeys -cacerts -out CACert.crt.

Unable to Configure Email Printing When SSL Is Enabled
for IMAP in GroupWise

If SSL is enabled for IMAP in GroupWise, you might be unable to configure email printing using the
iPrint Appliance Management Console.

To work around this issue, you must manually import the GroupWise certificate into iPrint
Appliance using the Management Console.

1 On a Web browser, use either the DNS name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Click the Appliance System Configuration icon.

Click Digital Certificates.

In the Key Store drop-down menu, select JVM Certificates.

Go to File > Import > Trusted Certificate.

Browse and select the GroupWise certificate, specify an Alias name, then click OK.

Click Close.

Click Reboot to reboot iPrint Appliance.
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After iPrint Appliance reboots, configure email printing from the iPrint Appliance Management
Console.

Upgrade Progress Bar Continues Processing

When upgrading iPrint appliance using the iPrint Appliance Management Console, the progress bar
continues processing. This issue is caused by the automatic update feature of the Web browser.

To work around this issue, close all open browser sessions, relaunch the browser, then wait for the
browser update to complete before upgrading iPrint Appliance.

Troubleshooting iPrint Appliance 97



16.19
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16.22

IPrint Rendering Service Fails to Start If the Windows User
Account Password Changes or Expires

The iPrint Rendering Service might not work if the password of the user account associated with the
service changes or expires.

To work around this issue, you must update the new password for the iPrint Rendering Service on
the Services utility.

Click Start > Run.

Specify services.msc, then click OK.

Right-click iPrint Rendering Service, then click Properties.

Click the Log On tab.

Under This account, update the new password, then click Apply.

Click OK.

Right-click iPrint Rendering Service, then click Start or Restart to start the service.

~N o 0o~ WN P

DataStore Creation Fails

When trying to create a DataStore, you might see a message: “Failed to parse the XML file: XML
document structures must start and end within the same entity.”

To work around this issue, run the configuration script located at Zopt/novell/iprintmobile/bin/
config.sh.

If you are still seeing the error, you must reinstall iPrint Appliance.

Garbage Characters Printed When Printing from Gmail on
Internet Explorer

If you are using Gmail on Internet Explorer and you try to print an email, you might see garbage
characters in place of line breaks. This is caused by a character encoding issue.

To work around this issue, you must change the default text encoding to UTF-8 in your Gmail
settings.

Launch Internet Explorer, then go to www.gmail.com.

Sign in to Gmail with your user name and password.

Click the settings icon in the upper-right corner of the screen, then select Settings.
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Under General settings, in the Outgoing message encoding section, select Use Unicode (UTF-8)
encoding for outgoing messages.

5 Click Save Changes.

“Canceled by Operator” Messages in the Audit Logs

In the audit log files, you might see the following message:

Canceled by operator

98 Novell iPrint Appliance 1.0.1 Administration Guide



This issue occurs if the files are not rendering correctly.

To work around this issue, ensure that the rendering service is active, and that the renderer is
configured correctly.

16.23 Printers Not Listed in PSM after Upgrading iPrint Appliance

When you upgrade iPrint Appliance, you might not see any printers listed in PSM (Print Manager).
To work around this issue, you must manually import printers from the source XML file.
1 Copy the source Print Manager XML (padbtxt.xml), available in the iprintconfig.zip file, to
the tmp directory, then rename the file to importRAWconfig.xml.

2 Import the change configuration to the new Print Manager database using the commands
rcnovel l-ipsmd stop and Zopt/novell/iprint/bin/ipsmd -x /tmp/
importRAWconfig.xml -u cn=admin,o=<0rgName>.

NOTE: Replace cn=admin, 0=<0rgName> with the LDAP distinguished name of the eDirectory
administrator.

3 Specify the eDirectory administrator password.

16.24 Unable to Create CUPS Printer Name with a Space
Character

When using the iprintmobile_config_driver command, you must specify the CUPS printer name
to associate the driver to a printer agent. When trying to create a CUPS printer, you might not be able
to add a space character in the name of the printer. If you try to add a space character, the following
message is displayed: Invalid command. This is a known limitation of the CUPS printer queue
names.

To work around this issue, you must specify CUPS printer names without any space characters.

16.25 Upgrading iPrint Appliance 1.0 Does Not Automatically
Export the License File

When upgrading iPrint Appliance 1.0 to a higher version, the license file does not get automatically
exported to the new version.

This issue is caused because the license file is not automatically backed up in iPrint Appliance 1.0.

To work around this issue, you must manually copy the license file from the license folder of iPrint
Appliance 1.0 to the license folder of iPrint Appliance 1.0.1. The license file for both versions of iPrint
Appliance is located at Zopt/novell/filr/apache-tomcat/webapps/ssT/WEB-INF/license/.
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Unable to Remove Inactive Renderer Entries from the
Management Console

On the iPrint Appliance Management Console, the inactive render entries might not automatically
get deleted after uninstalling the renderer.

To work around this issue, follow the procedure below.

1 Stop the Novell iPrint Mobile service through the Management Console.

For information on stopping or starting a service, see Section 8.6.1, “Starting, Stopping, or
Restarting System Services,” on page 63.

2 Launch the terminal.
3 Run the command iprintmobile_config_renderer -1 to get a list of renderers and their IDs.

4 Run the command iprintmobile_config_renderer -r <rendererlID> to remove the inactive
renderer.

5 Start the Novell iPrint Mobile service through the Management Console.

Upgrade Option Missing for iPrint Windows Renderer

When trying to upgrade iPrint Windows Renderer you might not find an upgrade option.

This is a known limitation of iPrint Windows Renderer. Novell plans to fix this limitation in a future
release.

To work around this issue, you must download and install the new version iPrint Windows
Renderer. Installing the new version of iPrint Windows Renderer automatically uninstalls the older
version.

After installing the new version, you must configure and register the renderer. For more information
on installing, configuring and registering the renderer, see Chapter 5, “iPrint Windows Renderer
Installation and Configuration,” on page 41.

LDAP Import Fails to Import Administrator User from Active
Directory Environments

When importing users from Active Directory environments, LDAP import fails to import the
administrator user account.

The Active Directory administrator user is not required for iPrint Appliance. iPrint Appliance
contains an in-built administrator account. The admin account of iPrint Appliance manages all users
imported from Active Directory.
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16.29

16.30

16.31

Disk Space Gets Filled Up During Continuous Job
Submission

When handling a large number of print requests, iPrint Windows Renderer might not be able
automatically delete the converted job data, and the disk space allocated for iPrint Windows
Renderer might fill up.

To work around this issue, you must manually delete the stored jobs.

1 Launch the command prompt.
2 Stop the iPrint Rendering Service manually using the command iPrntRendCmd -q.
3 Delete the files in the jobs folder located at C:\ndbs\renderer\jobs.

4 Start the iPrint Rendering Service using the command iPrntRendCmd -1.

Adobe Acrobat 11 Pro Hangs While Rendering PDF Files

When rendering PDF files using Adobe Acrobat 11 Pro, Adobe Acrobat might stop responding and
not complete the rendering process.

To work around this issue, kill Adobe Acrobat from Windows Task Manager, then try again.

Unable to Backup iPrint Appliance 1.0

When using iPrint Appliance 1.0, you may not be able to create a backup if you have a Driver Store in
excess of 6 GB. This is caused due to lack of disk space in the virtual machine.

To workaround this issue, you must add an additional hard disk to your virtual machine, then
backup iPrint Appliance 1.0. If your Drive Store is 10 GB in size, then you must add an additional 20
GB of hard disk space. The hard disk space must be twice the size of the resdir folder.

Power off the iPrint Appliance 1.0 VM.

In the vSphere client, right-click the iPrint Appliance 1.0, then click Edit Settings.

Click Add.

Select Hard Disk, then click Next.

Select Create a new virtual disk., then click Next.

Specify the Disk Size, then click Next.

Click Next on the Advanced Options screen.

Click Finish.

Power on the iPrint Appliance 1.0 VM.
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Create a partition using the fdisk command.

10a Run the command fdisk /dev/<disk name>.

10b When prompted for a command, specify n, then tap the Enter key.
10c For partition, specify p, then choose the default option.

10d When prompted for a command, specify w.

11 Create a file system using the command mkfs.ext3 /dev/<disk name>.

12 Stop the jetty service.
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13 Mount the /tmp folder to the newly added hard disk using the command mount /dev/<disk
name> /tmp/.

14 Start the jetty service.

After completing the procedure mentioned above, try backing up iPrint Appliance 1.0.

16.32 Port 515 (LPR) Disabled in the Firewall on iPrint Appliance

When enabling LPR access to iPrint Appliance, you may find that port 515 is disable in the firewall on
iPrint Appliance.

To work around this issue, you must manually add port 515 to the firewall exception list.
1 Login to iPrint Appliance using SSH.
2 Run the command yast2 firewall.
3 In the left pane, click Allowed Services.
4 Click the Advanced button in the bottom-right of the window.
5 In the TCP section, add port 515, then click OK.
6 Click Next to complete adding the port to the firewall exception list.
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7 Known Limitations

You might encounter the following limitations when using iPrint Appliance.

¢ Section 17.1, “General Limitations,” on page 103

¢ Section 17.2, “AirPrint Through iPrint Limitations,” on page 104

17.1 General Limitations

¢ The license file on iPrint Appliance 1.0 is not automatically backed up. To backup the license file,
you must add the absolute path of the license file manually into the additionalBackupList file
located at /etc/opt/novel l/iprintmobile/conf/additionalBackupList/. For example, if
your license file name is Iicense.xml, you must add the path Zopt/novell/filr/apache-
tomcat/webapps/ssT/WEB-INF/license/license.xml to the additionalBackupList file.

NOTE: On iPrint Appliance 1.0, the permissions for files/directories added to the
additionalBackupList file are not retained during backup. You must add the permissions
manually.

¢ When exporting the iPrint configuration file, iPrint Appliance does not export all csv files. iPrint
Appliance exports only the audit.csv which is the default audit file. If you want iPrint
Appliance to export additional csv files, you must add the path of those csv files manually into
the additionalBackupList file located at /etc/opt/novel I/iprintmobile/conf/
additionalBackupList/.

¢ When using email printing commands, the status, move, resume, and cancel commands might
not execute when used with the job name. If the commands do not execute with job names, use
job id instead.

¢ Email printing to secure printers is disabled. This is to enhance the security of your print system.

¢ When you upgrade or export iPrint Appliance, the iPrint Windows Renderer status might be
“Inactive.” To resolve this issue, you must unregister and re-register iPrint Windows Renderer.

¢ If you have configured a remote Driver Store, you cannot manage it through the iManager of
iPrint Appliance.

¢ If you want to create a local user or a local group account in iPrint Appliance, ensure that you
create the user or group account outside of the synced user’s context. This is because when you
sync from an LDAP source to iPrint Appliance, the user and group entries are imported into the
MySQL database of iPrint Appliance. By default, iPrint Appliance runs a sync to the MySQL
database every 8 minutes. If the local user or group account is not found in the MySQL database,
the account is automatically deleted during the next sync.

¢ Any configuration change in iPrint Appliance takes at least 20 minutes to get updated to the
configuration file. If you export the iPrint Appliance configuration file within 20 minutes of
modifying the configuration settings, and then import the configuration file into another copy of
iPrint Appliance, the changes are not captured. In this case, you might not be able view the
updated information in the iPrint Appliance. It is recommended that you wait at least 20
minutes after the last configuration change before you export the configuration file.
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The Novell iPrint app does not allow imported users to log in with the full user context.

The iPrint Windows Renderer installation interface is not available in Slovak, Hungarian,
Netherlands Dutch, or Catalan languages.

When trying to print an image through the Gmail app on Android devices, you might see the
message “Novell iPrint could not receive the document/image in a file format,” and the image
might not print.

Before installing or uninstalling Adobe Acrobat X Pro on the Windows 7 machine, you must
stop the iPrint Windows Renderer service using the command iprntrendcmd -g. If you do not
stop the iPrint Windows Renderer service, you might see a message that Microsoft Office
applications are running, and you might not be able to proceed with installation or
uninstallation.

If a user account synced from an LDAP source to iPrint Appliance is renamed at the source, the
user authentication fails. The user account is imported as a new object. Novell plans to address
this issue in a future release.

During LDAP import, empty groups are not imported.

iPrint Appliance Migration target server SSL authentication might sometimes fail. To work
around this issue, close the miggui application and launch it again.

If you install iPrint Windows Renderer on a non-English version of Windows 7, conversion of
Microsoft Excel files might fail.

You might find warning logs in the /var/opt/novell/log/iprintmobile/
iprintmobile0.log file. These logs are created if the file conversion takes more than two
seconds. You can ignore this warning as there is no functionality loss.

17.2  AirPrint Through iPrint Limitations
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Users submitting AirPrint jobs to non-secure printers are logged as Guest users in the iPrint
server audit log. This is because non-secure printers do not require user credentials to print.

If a user is not authorized to use a secure printer, the printer does not print because of an
authentication failure. The iOS device does not display any message to indicate the
authentication failure.

Users might be prompted for credentials for non-secure AirPrint printers.

Secure printing to AirPrint printers is supported only iOS 6.x. It is not supported on iOS 5.x and
iOS 7 .x.

“The printer is no longer available” message is displayed even if the printer is working fine.

If you print to a secure AirPrint printer by providing your credentials, the credentials are stored,
and you are not prompted for the credentials when you print to that printer in the future. This is
the default behavior of AirPrint.

Whenever a user prints to a secure printer, an "invalid request-URI" message is displayed in the
Apache error logs.
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Supported Document Formats

The following document formats have been tested and are known to work well with iPrint Appliance
printing.

Formats supported by the default renderer (Libre Office):

+ ODT
+ ODP
+ ODG
+ ODS
+ JPG
+ BMP
* TIF
+ GIF
+ PNG
¢ TXT
¢+ HTML (Static)

Formats supported by the external renderer (iPrint Windows Renderer):

¢ Microsoft Word Formats:
+ DOC
+ DOCX
¢ RTF

¢ Microsoft Excel Formats:
+ XLS
¢ XLSX

¢ Microsoft PowerPoint Formats:
¢ PPT
¢ PPTX

+ PDF

+ XPS (Non-certified)

NOTE: Libre Office can render PDF and Microsoft Office formats in the absence of iPrint Windows
Renderer. However, the output might not match the quality of iPrint Windows Renderer.
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B Email Service Parameters

B.1

¢ Section B.1, “Incoming Mail Server Parameters,” on page 107

¢ Section B.2, “Outgoing Mail Server Parameters,” on page 108

Incoming Mail Server Parameters

iPrint Appliance uses POP3 and IMAP protocols to access email servers to poll for email-based print

jobs. The default POP3 and IMAP protocol ports are listed below:

Protocol Path
IMAP 143
IMAP (Secure/IMAP4-SSL) 585
IMAP4 over SSL 993
POP3 110
POP3 (Secure) 995

The table below shows some examples of several incoming public mail servers.

This information has been retrieved from the proper email provider support pages. This is not an
exhaustive list. Please refer to your email provider for additional information and compatibility.

Mail Server Protocol Address Port Notes
1&1 POP3 pop.landl.com 995
IMAP4 imap.landl.com 143
AT&T POP3 pop.att.yahoo.com 995 SSL-enabled
AOL Mail IMAP imap.aol.com 143
Comcast POP3 mail.comcast.net 110
Google Gmail POP3 pop.gmail.com 995 SSL-enabled
IMAP 993 SSL-enabled
Hotmail POP3 pop3.live.com 995 Secure Password

Authentication (SPA)

Mac POP3 mail.mac.com 143
IMAP4 mail.mac.com 143
Netscape IMS POP3 pop.3.isp.netscape.com 110

Email Service Parameters
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Mail Server Protocol Address Port Notes

Verizon POP3 pop.verizon.net 110
995 SSL-enabled
Yahoo! POP3 pop.mail.yahoo.com 465 SSL-enabled
995 SSL-enabled
Yahoo! Plus POP3 plus.pop.mail.yahoo.com 995 SSL-enabled

B.2 Outgoing Mail Server Parameters

The iPrint Appliance uses SMTP protocols to send email back to users who submit email-based print
jobs in order to report their job status. The default SMTP protocol ports are listed below:

Protocol Port
SMTP 25
SSMTP (Secure SMTP) 465

This information has been retrieved from the proper email provider support pages. This is not an
exhaustive list. Please refer to your email provider for additional information and compatibility.

Mail Server Protocol Address Port Notes

1&1 SMTP smtp.landl.com 587

AT&T SMTP smtp.att.yahoo.com Requires

authentication

AOL Mail SMTP smtp.aol.com 587

Comcast SMTP smtp.comcast.net 110

Google Gmail SMTP smtp.gmail.com 465 SSL-enabled
587 TLS-enabled

Hotmail SMTP smtp.live.com 587 TLS-enabled

Mac SMTP smtp.mac.com

Netscape IMS SMTP smtp.isp.netscape.com 25 SSL-enabled

Verizon SMTP smtp.verizon.net 587 SSL-enabled

Yahoo! SMTP smtp.mail.yahoo.com 995 SSL-enabled

Yahoo! Plus SMTP smtp.mail.yahoo.com 465 SSL-enabled

108  Novell iPrint Appliance 1.0.1 Administration Guide



Traditional IPrint Client
Authentication

Desktop and laptop workstations based on the Windows or Mac OS can install a traditional iPrint
client to facilitate printing to printers managed by iPrint Appliance, as well as those managed by
traditional Novell Open Enterprise Server (OES) iPrint servers.

Printers managed by iPrint Appliance, as well as those managed by traditional OES print servers, can
be configured as “Public” or “Secure.” When a traditional iPrint client attempts to send a print job to
a “secure” printer, iPrint Appliance (or OES iPrint server) requires the traditional iPrint client to
authenticate. This authentication is performed either through a single sign-on experience or
manually.

¢ Manual Authentication: Manual authentication is invoked when the single sign-on experience
fails. When manual authentication is required, the iPrint client presents a login dialog where
users can supply their iPrint credentials (user name and password).

¢ Single Sign-on Experience: The iPrint authentication single sign-on experience is associated
with a base client OS authentication into an authentication realm, such as when a Windows
client logs in to an Active Directory domain. When the login is successful, Windows passes three
data fields (associated with the successful login) to the iPrint client running on the workstation.
This includes the authentication realm, the user name, and the password. The iPrint client
caches this information in anticipation of using it to facilitate a single sign-on experience when
authenticating with iPrint servers (including the OES iPrint server and iPrint Appliance).

When a traditional iPrint client attempts to send a print job to a secure iPrint managed printer,
the iPrint server (including the OES iPrint server and iPrint Appliance) sends an authentication
challenge back to the iPrint client. This challenge request includes a string that specifies an
authentication realm. If the authentication challenge indicates an iPrint authentication realm
that matches the realm cached by the iPrint client, the associated (cached) user name and
password are used to respond to the iPrint server's authentication challenge.

If the appliance-specified authentication realm does not match the authentication realm cached
by the iPrint client, or if the associated user name and password fail the authentication
challenge, then the iPrint client reverts to manual authentication.

The iPrint Appliance administrator can set the iPrint authentication realm (string) of the appliance.
This authentication realm is sent to traditional iPrint client workstations with authentication
challenges.

The iPrint authentication realm field is a string of characters. Traditionally, it is composed of
uppercase letters, numbers, underscore, and dash characters. When setting this value on iPrint
Appliance, consider the following;:

¢ Mobile clients that implement printing with AirPrint, IPP printing (via the mobile client), or
email based printing do not require association with an iPrint authentication realm. If the iPrint
Appliance only services mobile clients, the value specified for the iPrint authentication realm is
irrelevant. In this case, we suggest that the iPrint authentication realm value be set to a short
string that is unique to the installation instance, such as a company name, followed by a unique
internal instance identifier. For example:
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MYCOMPANY_IPRINT_VA_001

For traditional Windows Active Directory or iPrint clients to take advantage of the single sign-
on experience, the following conditions must be met:

¢ Clients must be associated with a specific Active Directory realm.

¢ The client’s Active Directory credentials (realm, user name, and password) must match
their iPrint Appliance credentials.

¢ The client must have the iPrint Appliance address set as the primary PSM address, using
the command iprntcmd -S <iPrintAppliance IP Address>.

In order to support traditional Windows Active Directory (fixed) iPrint clients, the iPrint
Appliance administrator should set the iPrint authentication realm field to match the Active
Directory realm.

The realm string used by workstations that authenticate using the (OES) Novell Client is the
associated eDirectory tree name.

In situations where Novell OES iPrint products have been implemented before installing an
iPrint Appliance, an iPrint authentication realm might have already been established for legacy
iPrint clients. The iPrint Appliance administrator can use the previously established iPrint
authentication realm, and also the same user names and passwords for iPrint Appliance. When
configured clients migrate between iPrint environments, the single sign-on experience continues
(uninterrupted) in both the OES iPrint environment, and in the iPrint Appliance environment.

Password Caching

When users change their passwords, secure printers might continue printing with the old password
for up to 10 minutes. This is caused by caching inside the iPrint LDAP authentication module, and
affects only the users created inside the local eDirectory tree on iPrint Appliance.

To resolve this issue, see Section 16.7, “Secure Printer Continues Printing after Changing the User
Password (Local Appliance eDirectory Users Only),” on page 92.
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D.1

Printing Using Specific Printer
Drivers

iPrint Appliance supports only PostScript printers by default. For non-PostScript printers like PCL,
or for printers that do not work with the default PostScript driver, you must install the appropriate
printer drivers.

NOTE: In iPrint Appliance 1.0, the spadmin tool method was recommended. In iPrint Appliance
1.0.1, the spadmin tool method is not supported. You must use the new procedure listed below to use
printer-specific drivers.

¢ Section D.1, “Using Printer Specific Drivers with LibreOffice,” on page 111

¢ Section D.2, “Using Printer Specific Drivers with iPrint Windows Renderer,” on page 112

Using Printer Specific Drivers with LibreOffice

To render documents, iPrint Appliance has a built-in renderer called LibreOffice. LibreOffice renders
open office formats (odt, ods, odp), images (jpg, png, gif, bmp, tiff), and text formats. LibreOffice also
has a built-in PostScript driver that is used to convert documents to print-ready formats for
PostScript printers. Additionally, you can configure add a printer-specific linux driver to one or more
CUPS printers.

1 Copy the driver file to your server.

2 Stop the Novell iPrint Mobile service through the Management Console. For information on
stopping or starting a service, see Section 8.6.1, “Starting, Stopping, or Restarting System
Services,” on page 63.

3 Launch the terminal, then run the command iprintmobile_config_driver -c
<CUPS_Printer_Name> -f <driver_file_path> -p <mobile_printer_name> | -d.

4 Start the Novell iPrint Mobile service through the Management Console.

Using this command you can create printer specific CUPS printers, and associate CUPS printer
drivers with the specific printers.

For example, if you want to configure the printer with the default driver, use the script
iprintmobile_config_driver -c DEFAULT -f /var/opt/novell/iprintmobile/drivers/
default_driver.ppd -p <mobile_printer_name>.

To configure the default driver as the global printer driver for mobile printing, use the command
iprintmobile_config_driver -c DEFAULT -f /var/opt/novell/iprintmobile/drivers/
default_driver.ppd -d.

The default driver bundled with iPrint Appliance is a PostScript driver. It is located at /var/opt/
novell/iprintmobile/drivers/default_driver.ppd.
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To remove a CUPS printer, run the command iprintmobile_config_driver -r <name of the
CUPS dummy printer to be removed>.

NOTE: Deleting a CUPS printer also deletes the printer driver from all the associated printers.

D.2 Using Printer Specific Drivers with iPrint Windows
Renderer

We recommend using iPrint Windows Renderer with the HP Universal Print Driver for Windows -
PostScript driver because this driver works with most printer models. However, if you have a specific
printer model that isn’t supported by these drivers (such as PCL), you can add the driver that is
specific to that printer model.

1 Launch the command prompt in the Run as administrator mode.

2 Run the command iPrntRendCmd.exe -c.

When prompted for service configuration credentials, specify the credentials of an account with
Windows admin and Log on as a service rights.

3 Specify No when prompted to reconfigure the server.
4 Specify Yes when prompted to change printer drivers.

5 Follow the on-screen instructions to change printer drivers.

NOTE: iPrint Windows Renderer uses a universal print driver. As a result, some print options might
not function as expected with certain printer models.
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Best Practices

iPrint Appliance strives to provide a seamless printing experience. Following the practices listed
below can ensure a highly efficient and highly available print system.

Spam Filters: When using email printing, the print command in the subject line might trigger spam
filters. To avoid this issue, configure your email system to allow print-specific emails. Include the
approved print users in the spam filter of your email system to prevent unwanted print requests.

Email Polling Interval: By default, the iPrint Appliance server polls the mail server for new email
every 30 seconds. If you rely heavily on email printing, you must reduce the polling interval for faster
response. However, you must ensure that your mail server is not overloaded by the frequent polling.

Custom Print Drivers: By default, iPrint Appliance supports only PostScript printers. The internal
renderer can print only to the PostScript printers. For non-PostScript printers like PCL, or for printers
that do not work with the default PostScript driver, you must install the appropriate printer drivers.
For more information, see Appendix D, “Printing Using Specific Printer Drivers,” on page 111.

DNS Configuration: We strongly recommend that you use a DNS resolvable host name for iPrint
Appliance. This host name is used by client devices when printing, and can cause failures if it is not
resolvable.

Time Sync: It is recommended that you sync the Virtual Machine host and the guest Virtual Machine
time to the same source.

Connectivity between iPrint Appliance and External Renderer: We recommend that you have a
high-speed connection between iPrint Appliance and the external renderer.

Connectivity between iPrint Appliance and Mail Server: If you rely heavily on email printing, we
recommend that you have a high-speed communication link between iPrint Appliance and the mail
server, in order to speed up the printing of email jobs.

Virus Scanner: We recommend that you use a virus scanner on the external renderer system (iPrint
Windows Renderer).

Applications on Windows Renderer: For best performance, do not run any other applications on the
Windows renderer machine.

Importing Users from Active Directory Source Using LDAP Sync: You might not be able to import
all users from the Active Directory source using LDAP sync. By default, only 1,000 users are returned
from Active Directory. This is caused by a default setting in Active Directory that limits LDAP
searches to 1,000 results. For more information, see the Microsoft support article: How to view and
set LDAP policy in Active Directory by using Ntdsutil.exe.

Partitions and Replicas Option in iManager: In iManager, you might see the Partition and Replicas
option. This feature is not required for iPrint Appliance. Therefore, it is not supported. We
recommend that you not use it on the iPrint Appliance eDirectory.

Creating Local Users and Groups in iPrint Appliance: If you want to create a local user or a local
group account in iPrint Appliance, ensure that you create the user or group account outside the
synced user’s context. This is because when you sync from an LDAP source to iPrint Appliance, the
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user and group entries are imported into the MySQL database of iPrint Appliance. By default, iPrint
Appliance runs a sync to the MySQL database every 8 minutes. If the local user or group account is
not found in the MySQL database, the account is automatically deleted during the next sync.

iPrint Windows Renderer Fails When Proxy is Enabled: If you have enabled proxy on the Windows
7 machine that is running iPrint Windows Renderer, the renderer might fail to process print jobs. To
workaround this issue, you must disable proxy.

iPrint Windows Renderer Fails to Register and Reports a 407 Error: When trying to register iPrint
Windows Renderer, the registration may fail, and you may receive a 407 error. To work around this
issue, add the certificate to the trusted certificates list.
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Installing VMware Tools

VMware tools is a collection of utilities that helps improve the performance of the virtual machine. To
install VMware tools for iPrint Appliance, download the latest version of VMware Tools from the
VMware website to the /tmp directory, then follow the procedure below.

1 Log into the ESX server using the vSphere client.

Right-click the iPrint Appliance VM, select the Guest option, then click Install/Upgrade VMuware
Tools.

Click OK on the pop-up message.

N

In the Console tab of the iPrint Appliance VM, log in using the root user credentials.

Create a folder named cdrom under the /mnt directory.

o O~ W

Navigate to the root directory, then mount the cdrom folder using the command mount /dev/
cdrom /mnt/cdrom.

~

Navigate to the /tmp directory.
8 Untar the VMware Tools tar file.

For example, tar zxf /mnt/cdrom/VMwareTools-5.0.0-<xxxx>.tar.gz. xxxx is the build/
revision number of the VMware Workstation.

9 Navigate to the vmware-tools-distrib folder.
10 Install VMware Tools using the command ./vmware-install.pl.
11 Choose the default settings for installation. When prompted, tap the Enter key for all the options.

12 Select the appropriate resolution, then proceed with the installation.

Verify that the VMware Tools daemon is running by using the command /etc/init.d/vmware-
tools status.
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Gl.2

IPrint Client Management with
Novell iPrint Appliance

iPrint Client Management (iCM) enables you to designate printers to be installed on a workstation
when a user logs in to the workstation. iCM also allows you to control the iPrint Client configuration,
making it easier to configure the iPrint Client without visiting each workstation. When the user logs
in to the workstation, the iPrint Client settings that you designate are configured on the user’s
workstation.

For more information on iCM, see the Using iPrint Client Management section in the iPrint Linux
Administration Guide.

ICM in OES Environment

Traditionally iCM was used in the following methods:

ICM with Novell Client

In OES iPrint, when a user logs in to the corporate eDirectory using the Novell Client, the iCM
settings are pushed to the user’s machine.

ICM without Novell Client

In iPrint Appliance, users cannot login directly using the Novell Client. This is because iPrint
Appliance syncs only user names from the corporate eDirectory, but not the passwords. For iCM to
work with iPrint Appliance, you can use one of the following methods:

+ Novell Client users continue to login to the existing corporate eDirectory instead of iPrint
Appliance. This way, the existing OES server is used for desktop printing, and the iCM settings
are available only in the source eDirectory.

Limitation: In this method, the iCM settings are fetched only from the source eDirectory. Any
iCM setting changes made on iPrint Appliance are not applied.

+ Use iCM without Novell Client. In this method, the local Windows/AD credentials must match
the eDirectory credentials. This method is suitable for an AD environment where users are
synced from AD to the local eDirectory so that the credentials are automatically matched. For
more information, see Section G.2, “iCM with iPrint Appliance,” on page 118.

Limitation: In this method, the iCM setting are fetched only from iPrint Appliance. iCM setting
changes made on the existing corporate eDirectory must be manually added on iPrint
Appliance.

NOTE: During migration from OES iPrint, iCM settings are not migrated to iPrint Appliance. Novell
plans to fix this in a future iPrint Appliance release.
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G2 ICMwith iPrint Appliance

iPrint Appliance does not support traditional iCM with the Novell Client. iPrint Appliance supports
iCM using Windows Local/AD credentials.

Depending on your environment, you can deploy iCM in the following ways:

G.2.1  Apply iCM Settings from the Original Tree

In this configuration, iCM settings are applied from the original tree if iCM is not migrated from OES,
and OES iPrint is still used for desktop printing and iCM. You can use this configuration with or
without the Novell Client.

The limitation of using this configuration is that the iCM settings are fetched only from the source
eDirectory. Any iCM changes made locally on iPrint Appliance are not applied.

G.2.2 Apply iCM Settings from iPrint Appliance eDirectory

In this configuration, iPrint Appliance is used for desktop printing, and iCM settings are created on
the appliance only.

With Novell Client: With iPrint Appliance, users cannot login directly using the Novell Client
because iPrint Appliance syncs only user names from the corporate eDirectory, but not the
passwords. Therefore, iCM cannot be used with Novell Client. iCM can be used against the source
eDirectory server.

Without Novell Client: To fetch iCM settings from iPrint Appliance, you can use iCM without the
Novell Client. In order for iPrint clients to use the Windows Local/AD credentials for iCM, the
following conditions must be met:

¢ You must set the iPrint Appliance address set as the primary PSM address on the client by using
the command iprntcmd -S <iPrintAppliance IP Address>.

¢ The client’s Active Directory user name must match their iPrint Appliance credentials. If you
import users from Active Directory to iPrint Appliance, the credentials are automatically
matched.

¢ In order for iCM to work with imported users and groups, you must enable browse/read rights
and inheritance for iCM for the following attributes, using iManager:

¢ iPrintPrinter][PPURI

¢ iPrintiCMClientFlags

¢ iPrintiCMClientProxyURI
¢ iPrintiCMClientTrayURI

¢ iPrintiCMPrinterFlags

¢ iPrintiCMPrinterList

¢ iPrintiCMTrustedSiteList
¢ Group Membership

IMPORTANT: For the user accounts imported from OES, iCM settings are not migrated. You must
reassign the iCM settings on iPrint Appliance for the OES user accounts.
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To configure the iCM attributes:
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On a Web browser, use either the DNS name or the IP Address to access iManager. For example,

https://10.0.0.1/nps or https://iprint.example.com/nps.

Specify admin as the user name.

Specify the password, then click Login.

In the left pane, under Roles and Tasks, click Rights.

Click Modify Trustees.

Under Object name, click the search icon, then choose the entire tree.
Click OK.

Click the Assigned Rights link next to the Public domain.

Click the Add Property button in the upper right of the table.

In the Add Property pop-up window, select Show all properties in schema.

In the Property name box, select the attributes listed above, then click OK.

Select the Inherit check box next to the attributes you added.
Click Done.

For more information on using Windows Local/AD credentials for iCM, see the Configuring iCM for

Windows / Active Directory (AD) environments without Novell Client section in the iPrint Linux

Administration Guide.

iPrint Client Management with Novell iPrint Appliance
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H.1

H.2

IPrint Appliance Support Matrix

This section provides information on the following.

*

*

*

Section H.1, “Mobile Server Support,” on page 121

Section H.2, “Mobile Operating System Support,” on page 121

Section H.3, “Directory Services Support,” on page 122

Section H.4, “Management Console Support,” on page 122

Section H.5, “iPrint Windows Renderer - Supported Operating Systems,” on page 123
Section H.6, “iPrint Windows Renderer - Supported Software Versions,” on page 123
Section H.7, “iPrint Appliance Server and Client Support,” on page 123

Section H.8, “Clients for Email Printing,” on page 124

Mobile Server Support

Table H-1 Moblie Server Support

Features Version
Driver + Default Generic PS driver
¢ PCL driver

NOTE: The PS driver has been tested and is
known to work well. However, PCL drivers also
work with iPrint Appliance.

Email * Novell GroupWise 2012

+ Microsoft Exchange 2010
+ |BM Domino server 9

¢ Gmalil

Mobile Operating System Support

Table H-2  Mobile Operating System Support for Apps

Type Version

i0S ¢ i0OS5.x
¢ iOS 6.x
¢ iOS 7.x
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Type Version

Android * Android 2.3.x Gingerbread
+ Android 4.0.x Ice Cream Sandwich
+ Android 4.1.x/4.2.x Jelly Bean

H.3 Directory Services Support

Table H-3 Directory Services Support

LDAP Directory

Service Version
eDirectory ¢+ 8.8
¢ 8.7.x
Active Directory + AD configured on
Windows 2008 R2

Enterprise Edition

+ AD Configured on
Windows 2003
SP1 Enterprise
Edition

H.4 Management Console Support

Table H-4 Management Console Support

Access Version
Browser ¢ |[E10
¢ |[E9

+ Firefox 21 or higher

+ Chrome 26 or higher

+ Safari 6 or higher

+ jOS 6.x tablet with default browsers

+ Android 4.x tablet with default browsers
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H.5

H.6

H.7

IPrint Windows Renderer - Supported Operating Systems

Table H-5 iPrint Windows Renderer Support

Support Version

Operating System .
*

*

Driver .

Windows 7 SP2 64-bit Enterprise
Windows 7 SP2 64-bit Ultimate
Windows 7 SP2 64-bit Professional

HP UPD 5.5 PS or higher

IPrint Windows Renderer - Supported Software Versions

Table H-6 iPrint Windows Renderer Support

Support Version

Microsoft Office .

*

Adobe Acrobat .

Microsoft Office 2010 64-bit Standard
Microsoft Office 2010 32-bit Standard

Adobe Acrobat X Pro or higher

iPrint Appliance Server and Client Support

Table H-7 iPrint Appliance Server and Client Support

Support Version

Hypervisor .

Desktop iPrint Client .

Xen

Hyper-V

ESXi 5.x

ESX 4

ESXi 4

VMware Workstation 9

Windows XP

Windows Vista

Windows Server 2000, 2003, 2008, and 2008 R2

Windows 8
Windows 8.1
Windows 7
Mac 10.8
Mac 10.7

iPrint Appliance Support Matrix
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Support Version

Appliance Installer * OVF
* VMX
+ XEN

H.8 Clients for Email Printing

¢ GroupWise 2012 client

+ Microsoft Outlook 2010

¢ IBM Lotus Notes 9

+ i0S 5/6 default mail client

¢ Mail clients on Android 2.3 or higher

+ Windows Mobile 7.5

¢ Blackberry 7.1

+ Windows 8 Pro default mail client on tablet

¢+ Gmail
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